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Cautions and Advisories

Cisco Spectrum Expert technology has been designed as a safe, reliable, user-friendly tool for advanced
spectrum monitoring. There are, however, a handful of actions which can inadvertantly cause difficulties
with using Cisco Spectrum Expert technology. There are also environmental factors beyond your control
which can cause unexpected behaviors.

Read the list of cautions and advisories below and the appropriate sections of the Users Guide in advance
to make the most effective (and trouble-free) use of the technology.

Installation—Be sure to install the Cisco Spectrum Expert Software on your laptop before inserting
the Cisco Spectrum Expert Sensor Wi-Fi (Sensor card) into your laptop’s PCMCIA slot. See
Installing the Cisco Spectrum Expert Software for more information.

Disconnecting the External Antenna from the Sensor card—You can achieve increased reception
sensitivity for RF signals by attaching an external antenna to the Sensor card. However, the
connector on the Sensor card is relatively fragile. Therefore, care must be taken when disconnecting
the antenna in order to avoid physical damage both to the Sensor card and the antenna. See
Removing the External Antenna for more information.

Using 802.11 Broadcast Technology with Cisco Spectrum Expert Software—Cisco Spectrum Expert
Software is designed specifically to monitor the RF spectrum in the bands used by 802.11
technology—the broadcast technology used for wireless computer networks.

If you are using Cisco Spectrum Expert Software, the technology will not function correctly if the
laptop which hosts Cisco Spectrum Expert Software (the laptop where you have installed Spectrum
Expert Software and inserted the Sensor card is also broadcasting its own signals in the Wi-Fi bands.

Your Cisco Spectrum Expert laptop cannot be part of a Wi-Fi network—that is, it cannot be
connected to a Wi-Fi access point or Ad-Hoc network, while you are running Cisco Spectrum Expert
Software. There are also limitations on using certain other network monitoring technologies on the
same laptop which hosts Cisco Spectrum Expert Software.

~

Note If the Sensor card is installed but you are not actually running Cisco Spectrum Expert, it is
okay to allow the laptop to participate in a network.

See Using Cisco Spectrum Expert With Other Onboard Laptop Technologies for more information.

If You are Not Seeing Any Data or Not Seeing Expected Data—Certain peculiarities of the RF
behavior can sometimes result in Cisco Spectrum Expert Software not showing any data or not
showing expected data (such as not displaying any device information for a device which you know
is out there). Failure to see data can also result from Cisco Spectrum Expert hardware not being
installed correctly. See What If I'm Not Seeing Any Data? for more information.

[ oL-15237-01
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Purpose

_— CHAPTER

Cisco Spectrum Expert Introduction

Cisco Spectrum Expert monitors the RF spectrum used by a variety of wireless network and
communications technologies, such as Wi-Fi (802.11) WLANSs. Cisco Spectrum Expert consists of a
hardware-based Spectrum Sensor card and GUI-based Cisco Spectrum Expert Software which provide
complete visibility of the RF environment in which wireless network technologies operate.

Other monitoring technologies typically focus on protocol-oriented network data which only provides a
picture of RF devices that are part of the network (or, in some cases, rogue devices which are attempting
to penetrate network security or jam the network). Cisco Spectrum Expert is designed to monitor and
report on the underlying, physical-layer RF activity which is shared by numerous devices that do not
share the network protocols. See Interferers: Classified (Named), Generic, and Unclassified for a list of
interfering devices.

Cisco Spectrum Expert can identify nearly all sources of RF activity in the unlicensed bands that
wireless networks share with other devices (such as cordless phone and headsets, Bluetooth devices, and
microwave ovens). Based on this data, network engineers can take steps to increase network performance
and security in the face of interferers, network congestion, and security attacks.

Cisco Spectrum Expert

Cisco Spectrum Expert monitors the 2.4 GHz and 5 GHz bands used by 802.11 networks in the
Americas, Australia, the Asia/Pacific region, Japan, and Europe.

Cisco Spectrum Expert Sensor Wi-Fi (Sensor card)

~

Note

LEDs

The Cisco Spectrum Expert Sensor Wi-Fi is also referred to as the Sensor card in this document.

The Sensor card has two LEDS that indicate its operational status. The Status LED (located on the right)
is a power indicator. When the Sensor card is plugged in, the Status LED should be green.

The other LED (Activity LED) indicates RF activity (Rx only). Possible states for the Activity LED
include:

e Off—Indicates that the Cisco Spectrum Expert Software is not running.

[ oL-15237-01
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Spectrum Bands

On or blinks green—Normal operational state. Indicates that the Cisco Spectrum Expert Software
is running and there is RF activity.

Red blinking—May indicate a hardware problem if the blinking is persistent.

~

Note Occasional red blinking can be expected.

On red—May indicate that the driver is not fully loaded. When the driver is successfully loaded, the
light should turn green.

Cisco Spectrum Expert supports various bands for spectrum monitoring.

Table 2-1 Supported Bands for Spectrum Monitoring

Product Bundle Sensor Card Abbreviated Actual Bands
Band Reference Supported
Wi-Fi 110C 2.4 GHz 2.4-2.5 GHz
5 GHz 4.9-5.9 GHz

Cisco Spectrum Expert provides a detailed, default channel scheme for each supported band. In addition,
you can define your own channel scheme. Channelization is discussed further “Local Settings
Overview.”

The Users Guide and Online Help

This manual provides an overview of Cisco Spectrum Expert and its principal features. Additional
information can be found in the Cisco Spectrum Expert Software online help system.

This document provides:

~

Cisco Spectrum Expert installation information for network engineers including information on how
to install the Sensor card in your notebook laptop.

Cisco Spectrum Expert configuration instructions.

A description of the comprehensive RF data displayed by the Cisco Spectrum Expert Software.

Note Installation information is also available in the Cisco Spectrum Expert Quick Start Guide.

Product Bundles

The following items are shipped with each Cisco Spectrum Expert Wi-Fi bundle:

One Wi-Fi 110C Sensor Card
One 2.4-2.5, 4.9-5.9 GHz external omni-directional antenna and antenna clip

Cisco Spectrum Expert Quick Start Guide
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Cisco Spectrum Expert

Caution

The external antenna attachment is a potentially sensitive component which is easily damaged. Take care
when removing (disconnecting) the external antenna. See “Removing the External Antenna” for more
information.

System Requirements

The following are the hardware requirements for installing and running Cisco Spectrum Expert:
e Notebook computer with Pentium series processor running at 1 GHz or faster.
¢ Windows XP Professional or Windows Vista Business (32 bit only) operating systems.
e 256 MB of RAM required (512 MB strongly recommended).
¢ Display resolution of 800 x 600 or higher (1024 x 768 recommended).
e 30 MB of available disk space.
® Available card slot.

e For Cisco Spectrum Expert, an 802.11 card or onboard 802.11 capability in order to monitor Wi-Fi
devices.

Using Cisco Spectrum Expert With Other Onboard Laptop Technologies

~

Note

If your computer has an 802.11 interface, it should be enabled in order to detect Wi-Fi devices. Note that
if you are connected to an AP or Ad-Hoc network through the 802.11 interface, you will occasionally
see strong signals on the spectrum plots that are measurements of your own 802.11 transmissions. But
as long as your network transmissions are not excessive, Cisco Spectrum Expert will still operate
correctly in the presence of these signals.

Other Monitoring Technologies

Cisco Spectrum Expert can share your laptop with some other passive monitoring technologies. It can
run concurrently with WildPackets AeroPeek, AirMagnet Laptop Analyzer, or AirMagnet Surveyor
without an inappropriate degradation in product performance.

This assumes that your laptop can accommodate the required number of Sensor cards.

Some of these other monitoring technologies (such as AirMagnet Surveyor) also have “active” survey or
monitoring modes that transmit packets to nearby access points. If you have one of these cards installed
in the same laptop with Cisco Spectrum Expert, it is important to not use these active transmission modes
because they interfere with the proper operation of Cisco Spectrum Expert.

[ oL-15237-01
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~

Note  The products indicated above—AeroPeek, Laptop Analyzer, and Surveyor—offer monitoring
capabilities which are complementary to those provided by Cisco Spectrum Expert. Although these
products offer extensive 802.11 information, Cisco Spectrum Expert offers increased depth of physical
layer (RF emissions data), identification of interfering devices, and more extensive spectrum plotting
and related data (such as duty cycle measurements and other measures of overall RF activity).

Concurrent 802.11 (Wi-Fi) Protocol Support

The Cisco Spectrum Expert Software detects the presence of Wi-Fi support in the laptop, either on the
system board or as another sensor card. If so, and if you are using Cisco Spectrum Expert, the software
provides basic support for 802.11 protocol monitoring in the Devices View (See “Working With Devices
View” for more information) and Device Finder (See “Device Finder Mode” for more information)
features of the software.

Cisco Spectrum Expert Users Guide
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Analysis and Cisco Spectrum Expert

This section provides an overview of Cisco Spectrum Intelligence technology and Cisco Spectrum
Expert which implements that technology.

Cisco Spectrum Intelligence

Cisco Spectrum Intelligence addresses several current shortcomings in radio frequency (RF) network
technology. These shortcomings exist in numerous RF domains such as the WLAN technology used by
802.11 computer networks. These shortcomings fall into several inter-related categories.

RF Visibility and Unlicensed Bands

Currently, RF network system administrators lack sufficient awareness of the RF environment in which
their access points and stations (for WLANS) operate. Issues arise from the fact that many RF network
technologies operate in unlicensed bands. This means that multiple technologies—technologies which
are not meant to interoperate and which represent different aspects of the RF infrastructure—compete
for use of the same bandwidth.

Discovery
Current network technologies, such as those used to monitor 802.11 WLANS, are only aware of other
network elements. They are unable to discover other nearby sources (competing technologies) emitting
radio frequency signals in the unlicensed bands.

Performance

e  Wi-Fi—WLANSs operate in the unregulated 2.4 GHz and 5 GHz bands and are subject to
interference from other devices operating in this same frequency spectrum such as microwave ovens,
cordless phones and cordless headsets, wireless surveillance cameras, garage door openers,
Bluetooth technology, and other devices. There can also be co-channel interference (CCI) due to
neighboring WLANSs. These competing devices can degrade 802.11 network performance resulting
in slow data rates and excess packet retransmissions. There is a CCI category in the Interference
Power chart for displaying the CCI impact on your network.

Cisco Spectrum Expert Users Guide
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Troubleshooting

¢  Wi-Fi—Current WLAN technologies are aware of network devices so they can determine if there is
excess load on the network from network stations. Current technologies cannot see the whole RF
spectrum in the unlicensed band and cannot identify sources of RF activity which can cause dropped
network connections and other problems.

Summary

Current 802.11 (Wi-Fi) technologies offer protocol-level awareness, but not physical layer (RF)
awareness. Lacking full RF spectrum awareness, existing WLANSs cannot apply appropriate, adaptive
responses to improve performance in the face of interferers and competing networks.

Cisco Spectrum Expert: Mitigation and Performance Enhancement

Cisco Spectrum Expert includes sophisticated technology to detect and classify sources of RF activity.
Using this data, network engineers can use a variety of methods to enhance Wi-Fi WLAN performance
and reliability. Some of these methods are listed below:

Clean Channels

If a certain part of the frequency spectrum is in constant use by other devices, the network engineer can
program the network to not transmit over those channels. By deliberately searching for “clean” channels,
the network devices can be set to broadcast over those channels.

Identifying, Locating, and Removing Interferers

Cisco Spectrum Expert can identify the types of devices which are producing RF interference. An
interferer is any non-network RF device which broadcasts in the same frequency bands as network
devices and can cause disruption to your network. For example, in the 802.11 domain, typical interferers
include microwave ovens, cordless headphones and headsets, 802.11 FH devices, and Bluetooth devices.
The network engineer is alerted to the presence of these devices and can take steps to address the
problem (including relocating or shutting off the devices).

With Cisco Spectrum Expert Software, the network engineer can also use Cisco Spectrum Expert
Software’s Device Finder mode which makes the Cisco Spectrum Expert-enabled computer into a
lightweight homing device to track down the precise location of the signal source. (See “Device Finder
Mode” for more information.)

e

Tip The optional directional antenna, available from Cisco, can help with determining the location of Wi-Fi
devices.

Device Specific Solutions

By knowing the ID of specific interfering devices, custom solutions can also be tailored to specific
technologies and specific brands of these technologies.

Cisco Spectrum Expert Users Guide |
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The Cisco Spectrum Expert Solution

Cisco Spectrum Expert is a combined hardware and software technology which implements Cisco
Spectrum Intelligence technology. Cisco Spectrum Expert makes the 802.11 WLAN system “spectrum
savvy”, ensuring greatly increased reliability and performance. Cisco Spectrum Expert consists of two
primary components:

e Sensor Card—Sensor cards provide the hardware foundations for Cisco Spectrum Intelligence.
Each Sensor card incorporates SAgE ASIC, a powerful spectrum-analyzer-on-a-chip. SAgE
provides full visibility for the RF spectrum in the unlicensed bands where Wi-Fi WLANSs operate.

¢ Cisco Spectrum Expert Software—The Cisco Spectrum Expert Software analyzes data from the
Sensor card and provides a GUI-based view of network and RF activity.

With Cisco Spectrum Expert, the Sensor card and application are integrated into one convenient
platform. A network engineer uses the application’s device finder mode to observe how the signal
strength from an interferer varies as he moves about the enterprise. This makes it possible to quickly
pinpoint the location of the interfering device.

Spectrum Sensor Card

As a first step in the spectrum analysis process, the ambient RF environment must be scanned and
analyzed to determine the sources of RF activity in the neighborhood of the network, especially causes
of interference or other problems.

The essential internal components of a Sensor card include:
e Radio—The radio transceiver detects the RF spectrum and feeds this data to SAgE.

¢ SAgE—The Spectrum Analysis Engine (SAgE), performs a Fast Fourier Transform (FFT) of the RF
spectrum and provides the feed of low-level data concerning the behavior of the RF spectrum.
Low-level data includes basic information on the power vs. frequency in the spectrum at a given
instant and information on individual pulses in the RF spectrum.

SAgE also performs on-board statistical analysis of the spectrum and statistical analysis of RF
pulses (which relieves external MCUs or CPUs of this processor-intensive task).

e CPU—To be fully useful, data from the Sensor card requires further software analysis from a
microprocessor. The Sensor card borrows some of the processing power from the laptop’s
microprocessor (CPU) to perform these calculations. The CPU provides low-level analysis of the
data stream. The analysis engines include:

— Measurement Engine—Aggregates SAgE data and normalizes it into meaningful units.

— Classification Engine —Identifies specific types of interferers (Bluetooth devices, microwave
ovens, cordless phones and headsets, radar, etc.).

The Cisco Spectrum Expert Software

The Cisco Spectrum Expert Software runs under Windows XP (Service Pack 2 or later) or Windows
Vista operating systems. The application provides the interface (GUI) which connects the network
engineer with the resources available from the Sensor card:

Cisco Spectrum Expert Users Guide
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e Channel Summary—Provides a statistical overview of RF activity (such as power levels and
number of interferers present) on a per-channel basis. This view gives you an instant picture of
which channels are subject to excess interference, and which channels have the best potential for
trouble-free network activity. See the “Working with the Channel Summary” section for more
information.

¢ Device Finder—In Device Finder mode, Cisco Spectrum Expert Software is a convenient,
user-friendly RF “sniffer” optimized for displaying RF power data in a way that quickly enables the

network engineer to track down interfering devices. See the “Device Finder Mode” section for more
information.

¢ Tools—Supports configuration of Cisco Spectrum Expert Software. See the “Tools Menu” section
for more information.

Cisco Spectrum Expert Online Help

Detailed reference information is found in Cisco Spectrum Expert Online Help system, which can be
accessed by selecting Help > Help Topics.

Cisco Spectrum Expert Operating Scenarios

Cisco Spectrum Expert can be used in several different modes which are described below:

S

Note  For detailed instructions on using Cisco Spectrum Expert in real-world applications, see the “Cisco
Spectrum Expert and Real World Applications” section.

Firefighting Mode

Critical Tasks:

e Identify, diagnose, and resolve problems in the RF environment as quickly as possible.

Centerpiece Applications:

Cisco Spectrum Expert Users Guide |
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e Spectrum Charts

e Devices View

e Device Finder

e Channel Summary

Typically, the IT Administrator will have the Cisco Spectrum Expert Software running with the Channel
Summary or one or more Spectrum Plots and Spectrum Charts in view. Spectrum Charts, in
particular, are an important resource for detecting problems that may stress the network.

¢ The Channel Utilization chart—Indicates when one or more channels are becoming overloaded
with devices.

¢ The Channel Utilization chart—Indicates when one or more channels have an overall excess of RF
activity which may be due either to device overload, or interferers, or both.

Once a problem occurs and before it progresses too far, the Administrator can determine and isolate the
cause of the problem through a combination of the Devices View, Channel Summary, and the Device
Finder.

An RF expert is an individual with an advanced knowledge of radio frequency technology and its
associated physics and electronics. This individual is familiar with the use of spectrum analyzers as well
as the inner workings of wireless network systems. An RF expert is most likely to be involved with
installations where the wireless system is considered mission critical.

The RF Expert uses Cisco Spectrum Expert as a 24 hour-per-day, 7-day-per-week spectrum analysis tool.

Critical Tasks:
¢ Investigate reported spectrum events at the raw RF level.
e Review raw RF data for cases that are unclassified by Cisco Spectrum Expert Software.
¢ Confirm that recommended solutions have alleviated the problem

Centerpiece Application: Spectrum Analyzer Plots

The RF Expert primarily uses the detailed Spectrum Analyzer plotting capabilities of Cisco Spectrum
Expert Software’s Spectrum Plots. When he is called in on a problem, he uses the Spectrum Plots to
confirm and/or supplement the intelligence capabilities built into Cisco Spectrum Expert Software.

For example, if Cisco Spectrum Expert Software reports that a video interference signal is occurring, the
RF expert may wish to view the Power Vs. Frequency and Real Time FFT plots to confirm that it is
not some other type of device. In addition, there will always be cases where Cisco Spectrum Expert
Software does not recognize the type of interference at work. In that case, the human intelligence of the
RF expert helps fill in the missing gaps.

Another critical use of the Spectrum Analyzer capabilities is to confirm when a problem has been fixed
by corrective action. When a fix has been attempted, the IT department can’t afford to wait until the next
day to see that no problems re-surface. The RF expert can use the Spectrum Analyzer functions to
perform before-and-after comparisons that confirm that a fix (for example, shielding was placed around
an interference device) has indeed fixed the problem. These comparisons are enabled by Cisco Spectrum
Expert Software’s record/playback capabilities.

See the “Spectrum Instant Replay” section for more information.

| oL15237-01
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Site Survey—Network Install and Initial Configuration

Cisco Spectrum Expert Software is an invaluable tool for supporting pre-installation Wi-Fi site surveys,
and also for the initial installation and configuration of a WLAN system.

Critical Tasks:

e Set channel usage for Wi-Fi access points

e Pre-emptive interference mitigation
Centerpiece Applications:

¢ Spectrum Plots and Charts

e Device Finder

e Channel Summary

e Devices View

Cisco Spectrum Expert Software can be used prior to deployment of a Wi-Fi WLAN network, to obtain
information which is essential for planning an optimum deployment.

¢ Band and Channel Allocations—Cisco Spectrum Expert Software can determine which bands or
channels have the most RF activity. Wi-Fi access points can then be programmed to use other
channels, resulting in higher speed transmissions, and reduced packet retransmissions.

¢ Pre-emptive Interference Mitigation—Any interferers which are discovered to be contributing
significant RF activity can be moved, de-activated, or shielded, before putting the WLAN system
into operation.

e Access Point Placement—As a lightweight, mobile RF probe, Cisco Spectrum Expert Software can
determine which general areas have the highest level of RF activity—as determined by the Devices
View, the Device Finder, and the Spectrum Plots and Charts—and therefore require the most
access points for adequate network coverage.

Technical Concepts

Duty Cycle

Cisco Spectrum Expert Software is designed to make the RF spectrum accessible even to non-experts by
performing a tremendous amount of high-level analysis on behalf of the user. For example, Cisco
Spectrum Expert Software can classify interfering devices, sparing the user the necessity of interpreting
a spectrum graph to determine which kinds of interfering devices are present.

At the same time, Cisco Spectrum Expert Software provides a great deal of more technical information
and some familiarity with RF concepts is helpful. Neither this manual nor the online Help system
attempts to present a detailed discussion of radio frequency theory, but a few concepts are worth some
clarification.

Among the various measures of RF power, Cisco Spectrum Expert Software includes the ability to
measure and report on the RF duty cycle. Duty cycle is a general term which relates to how much RF
energy is present in the spectrum, as measured not by raw RF power (not in watts or dBm), but rather in
terms which indicate how much RF power is present in some operational or functional sense. The goal
is to have a measure of RF power which suggests how much impact the RF power will have on network
performance. Cisco Spectrum Expert Software uses two different measures of duty cycle:

e The percentage of time that the RF signal is 20 dB above the noise floor.

Cisco Spectrum Expert Users Guide
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e The percentage of time a transmission from a known device is present in the channel or band.

Throughout this manual we indicate which measure of RF power is used by various Cisco Spectrum Expert
Software display modes. The Online Help also includes a topic (Duty Cycle in the Background
Information folder) which compares the usage of duty cycle in various contexts in the Cisco Spectrum
Expert Software.

Device Classifiers

You, as the user, make the vital distinction between network devices (Wi-Fi) and interferers. In addition,
the Cisco Spectrum Expert Software supports this distinction, in terms of how data is structured and
classified on the display. However, the underlying technology used to detect and classify both network
devices and interferers is the same. Cisco has developed advanced classifier algorithms, which run on
the processor on your laptop. These classifier algorithms use the spectrum data from SAgE (discussed
above) to categorize devices which are part of your network, or which can interfere with your network.

The classifiers supported in Cisco Spectrum Expert Software 3.2 include:
e  Wi-Fi Access Points
- In-Network
- Known
- Unknown
— Ad Hocs
e Wi-Fi Stations
e A wide variety of Bluetooth devices
e A wide variety of cordless phones
— Cordless Phone, 2.4/5.8 GHz, DECT1
— Cordless Phone, 2.4/5.8 GHz, DECT2
— Cordless Phone, 5.8 GHz, DECT3
— Cordless Phone, 2.4 GHz, TDD/Fixed Channel variant 1
— Cordless Phone, 900 MHz, FHSS variant 1
e Microwave Ovens
e Generic Fixed Frequency
e Generic Frequency-Hopped
¢ Generic Continuous transmitters (e.g., FM Phones, NTSC, etc.)
e RF Jamming devices
e 802.11FH devices
e Analog Video
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Generic Device Classifiers

Cisco Spectrum Expert supports the ability to classify “generic” devices. Generic devices cannot be
linked to a specific device type, manufacturer or transmission protocol. They are identified by their
physical layer transmission characteristics. An example of such a device is a cordless phone that uses an
unrecognized transmission protocol to exchange data with its base station (i.e., a phone that doesn’t use
Bluetooth, 802.11FH, TDD or DECT).

The following list of generic signals recognized by Cisco Spectrum Expert 3.2 is subject to revision
without notice:

Pulse Type | Analog or | Modulation Type Output Parameters
Digital

Continuous Digital FSK RMS power, bandwidth, coarse and fine CF !
Continuous Digital OFDM RMS power, bandwidth
Continuous Analog FM RMS power, bandwidth, coarse and fine CF
Continuous Analog CwW RMS power, coarse and fine CF

Burst Digital FSK RMS power, bandwidth, symbol rate, coarse and fine

CF, burst period
Burst Digital OFDM RMS power, bandwidth, burst duration

ICF = center frequency, PAP = peak-to-average power

In the Active Devices List, these devices will be identified via a hierarchical listing which will indicate
the pulse type, modulation type, and possibly the frequency. For example:

Generic Devices [5]
Burst, Fixed Frequency [3]
Channel Group @ 2431.3 MHz [2]
Device 1 (FSK)
Device 2 (FSK)
Channel Group @ 2434.3 MHz [1]
Device 1 (FSK)
Continuous [2]
Device 4 (CW) @ 2430.1 MHz
Device 7 (FSK) @ 2440.1 MHz

The bracketed numbers indicate the number of devices.

A similar naming scheme is used in the Devices View.

Interferers: Classified (Named), Generic, and Unclassified

As indicated in Section Device Classifiers on page 7 immediately Device Classifiers, Cisco Spectrum
Expert classifies many different interferers — that is, devices which are not network devices, but which
produce RF power in frequency bands that affect your network. For purposes of Cisco Spectrum Expert
operations, there are three broad categories of interfering devices:
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Classified Named Interferers

For many interfering devices, Cisco Spectrum Expert can detect and classify the type of device, in some
cases to the extent that it can name the specific model of device in question. So, for example, Cisco
Spectrum Expert will not only identify an interferer as being a Bluetooth device, it will also indicate a
brand name and model. However, for our purposes, a “named” device is one for which Cisco Spectrum
Expert can indicate the category of operation (Bluetooth, microwave oven, cordless phone, etc.). The
user interface displays a picture of a typical device that matches the RF signature when a user
double-clicks on a device in the Active Devices pane or Devices View.

Classified Generic Interferers

These are devices for which Cisco Spectrum Expert has a great deal of technical information about the
signal from the device, such that the general nature of the RF emitter can be identified. However, the
Cisco Spectrum Expert system does not present a name (such as DECT2, or Bluetooth); and Cisco
Spectrum Expert does not present a list of devices (product names) that can be in this category.

For the generic devices, Cisco Spectrum Expert provides the kind of signal details indicated in the table
in Section Generic Device Classifiers on page 8, Generic Device Classifiers. In fact, what Cisco
Spectrum Expert essentially provides are detailed parameters about the RF signal from the device, rather
than about the device per se.

Example: In the case of “Continuous Transmitter FSK”, “Continuous” means the device
transmits continually rather than in bursts; “FSK” refers to the signal modulation.
(“FSK” stands for Frequency Shift Keying.) Specific devices, such as DECT2 devices, are
also “continuous FSK” transmitters; but if Cisco Spectrum Expert does not identify the
interferer as, say, DECT2, it’s because other expected transmission properties of DECT2
devices were not detected. Hence, Cisco Spectrum Expert only provides the broader, generic
classification based on the type of signal.

Unclassified Interferers

Note

An “unclassified interferer” is literally one that Cisco Spectrum Expert does not classify. That means it
is not identified, as a device per se, anywhere on the screen (such as in the Devices View or the Active
Devices list). It also means the device is not included in counts of devices. On the Channel Summary
display, the Interferer Duty Cycle field does not include measurements of unclassified interferers.'
However, Cisco Spectrum Expert still does see RF energy from unclassified interferers. See the
following note.

The plots and charts which show RF power (Real Time FFT, Power vs. Frequency, and the Swept
Spectrogram) or duty cycle (FFT Duty Cycle, Channel Utilization, Channel Utilization vs. Time,
and Swept Spectrogram) do show all RF power / duty cycle detected by the Sensor card, regardless of
the source. So, power/duty cycle from unclassified interferers is also included.

Naturally, Cisco tries to minimize the number of interferers that Cisco Spectrum Expert cannot classify
at all.

1. The Interferer Duty Cycle on the Channel Summary is an estimate of the percentage of the time that a
transmission is present in the channel or band. To be included in this estimate, the transmission must be
associated with a known, identified device. So, transmissions from unclassified interferers are automatically
excluded. In addition, it is possible that there may be some transmissions from generic interferers which Cisco
Spectrum Expert cannot actually identify as belonging to those devices. Those transmissions are also not
included in the Interferer Duty Cycle shown on the Channel Summary.
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Cisco Spectrum Expert Setup

The section discusses the physical setup of the Cisco Spectrum Expert, along with software installation.

Be sure to install the Cisco Spectrum Expert Software before installing the Sensor card into your
computer. If you have installed the Sensor card first, see the “Repairing a “Backwards” Installation”
section for more information.

Downloading the Cisco Spectrum Expert Software

~

Note

Step 1
Step 2
Step 3

Install the Cisco Spectrum Expert Software before installing the Sensor card in the slot in your computer.
See the User’s Guide for more information.

To download the Cisco Spectrum Expert Software, follow these steps:

Go to http://www.cisco.com/kobayashi/sw-center/sw-wireless.shtml.
Under Cisco Spectrum Expert, click the Cisco Spectrum Expert Software Release link.

Select the most current download (.exe) file for your operating system.

Installing the Cisco Spectrum Expert Software

To install the Cisco Spectrum Expert Software, follow these steps:

Step1  Click on the downloaded executable setup program to initiate the installation wizard.
Step2  If security warning screens appear, click Run or Yes to confirm and continue.
Step 3 From the Welcome screen, click Next.
Step4  On the License Agreement screen, review the Cisco Software license agreement and select the I accept
the terms in the license agreement checkbox.
Step5  Click Next.
[ OL-xxxxx-xx
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Step 6 On the Customer Information screen, enter your User Name and Organization.
Step7  Click Next.

Step8  On the Destination Folder screen, click Next to confirm the default install destination.

Installing the Sensor Card in the Laptop Slot
~

Note  Install the Cisco Spectrum Expert Software before installing the Sensor card into an available slot in
your computer.

The Sensor card contains Cisco’s custom hardware, the SAgE chip, for detecting RF spectrum activity.

To install the Sensor card, follow these steps:

Step 1 Insert the Sensor card into an open slot (i.e., a PCMCIA Card slot) on your laptop.

~

Note  The pins go in first with the LEDs on the card facing upward.

Step2  Press the card gently but firmly into place.

Step3  Windows XP and Vista should automatically detect the hardware and install the necessary drivers for the
Sensor card.

~

Note  Once the installation is complete, a Windows XP or Vista pop-up window indicates that the
hardware has been installed.

Step4  When a dialog box indicates the installation is complete, click Finish.

Attaching the External Antenna

The Sensor card has an internal antenna, however we recommend using the external omni antenna
(included) for improved detection sensitivity. An external directional antenna can also be ordered from
Cisco (optional).

A

Caution  To avoid damaging both the connector and the Sensor card, use caution when detaching the external
antenna. See the Cisco Spectrum Expert User’s Guide for detailed instructions.

A

Caution  Significant repetition (over 500 times) of connecting and disconnecting the external antenna may
degrade the connector’s performance.

Cisco Spectrum Expert Users Guide
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Attaching the External Antenna

To attach the omni antenna, follow these steps:

Step1  Attach the antenna holder clip to the top of the computer’s display panel.
Step2  Slide the antenna vertically into the round, horizontal holder with the
swivel base above the antenna holder clip.
Step3  Install the antenna’s cable into the external jack on the Sensor card using
the cable plug (MMCX male connector).
Directional Antenna
To attach the directional antenna, follow these steps:
Step1  Mount the Velcro strip to the back of the PC using the strip’s adhesive backing.
Step2  Attach the plastic holder to the Velcro strip.
Step3  Slide the antenna’s support staff into the slot holder.
Step4  Install the antenna’s cable into the external jack on the Sensor card using the cable
plug (MMCX male connector).
See the Cisco Spectrum Expert User’s Guide for more information on how to make
effective use of the directional antenna.
Cisco Spectrum Expert Users Guide
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Removing the External Antenna

A

Caution

A

Care must be taken when removing (disconnecting) the external antenna. If the plug is not removed
carefully, either the MMCX antenna jack on the Sensor card, or the Sensor card itself may be
permanently damaged.

Why didn’t Cisco use a more robust connector for the antenna? Certain technical requirements create
limits on the connector that can be used. It must be thin enough to fit in a Sensor card. Also, the
extremely high frequencies involved demand a special connector which can carry these frequencies
across the connection with minimal signal loss. Very few connectors can meet these stringent
requirements, and we have selected what we believe is the best connector for the purpose at hand.
Unfortunately, it is relatively fragile, and requires careful handling to avoid damage.

The antenna should NEVER be disconnected by pulling on the antenna lead (the wire connecting the
antenna to the Sensor card) to avoid causing damage to the cable, connector, and Sensor card.

Caution

Note

Step 1

Step 2

Failure of the user to follow the instructions below can cause the antenna or Sensor card to become
inoperable, and failure to properly disconnect the antenna may lead to voiding the warranty.

Essentially, the requirements for removing the external antenna is to make sure you are pulling the plug
straight out of the jack.

You may find it easier to detach the antenna if you first remove the Sensor card from the slot. This way,
you can hold the Sensor card in one hand, while grasping the antenna jack in the other. See the
“Swapping or Removing the Sensor Card” section for more information.

To safely remove the plug, follow these steps:

Grasp the plug—the part at the end of the antenna wire—at the end of the antenna lead where it is mated
to the Sensor card.

The best method is to “pinch” the connector with the thumb and forefinger, and with the nails, or the tips
of the fingers, under the shoulders of the connector.

Pull the connector firmly and PERPENDICULAR to the edge of the card.

In other words, you need to carefully get a grasp on the plug—we recommend you actually use your
fingernails, sliding them so as to create a gap between the plug and the jack—and gently but firmly pull
the plug in a direction that is directly at right angles to the Sensor card. (And perpendicular to the laptop,
if the Sensor card is still inserted in the laptop.) To the extent possible, you should be gripping the plug
with equal, balanced pressure from opposing sides, using two or three fingers.

What you do not want to do is to apply any pressure to the left or right, or up or down.
We recommend you avoid a twisting motion as well. The photo below illustrates the recommended
technique.
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Using the Directional Antenna

The purpose of the directional antenna is to focus RF detection activity in a given direction. This can be
useful with all Cisco Spectrum Expert Software features, but is especially useful with the Device Finder
(See the “Device Finder Mode” section for more information). The following diagram illustrates the
directional sensitivity of the directional antenna which you can order from Cisco.

Swapping or Removing the Sensor Card

Normally, you would not want to remove the Sensor card while the Cisco Spectrum Expert Software is
running. However, you can in fact remove the Sensor card, and re-insert it, without degrading system
performance.

If you do remove the Sensor card while the software is running, a pop-up will appear directing you to
re-insert the card, and hit [OK] to continue.

Cisco Spectrum Expert Software Startup

~

When Cisco Spectrum Expert Software and the Sensor card are installed, Cisco Spectrum Expert
Software can identify sources of interference in the neighborhood of your network.

Note  If your computer has an 802.11 interface, it should be enabled in order to detect Wi-Fi devices. Note that
if you are connected to an AP or Ad-Hoc network through the 802.11 interface, you will occasionally
see strong signals on the spectrum plots that are measurements of your own 802.11 transmissions. But
as long as your network transmissions are not excessive, Cisco Spectrum Expert Software will still
operate correctly in the presence of these signals.

To start the Cisco Spectrum Expert Software, follow these steps:
Step1  From the Start menu, select All Programs > Cisco > Cisco Spectrum Expert or click the desktop icon.
~

Note If you receive a Windows security alert for a Spectrum Expert-related program called Sensord, select
the Unblock option.

Step 2 From the Connect to Sensor dialog box, choose from:
e Sensor Card with Internal Antenna
e Sensor Card with External Antenna
e Spectrum Capture File
>
Note If you choose Spectrum Capture File, click Browse to identify the applicable file.
Step3  To identify these settings as default, select the Automatically start sensor connection with these
settings next time application is launched check box.
Step4  Click OK to access the Cisco Spectrum Expert Software application.
Cisco Spectrum Expert Users Guide
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Note Upon starting Cisco Spectrum Expert Software, you may see a dialog box indicating that there is no 802.11
capability in your laptop. Cisco Spectrum Expert Software will work, but will not detect 802.11 devices.
See “Cisco Spectrum Expert Software and Your Laptop” for more information.

Note  Depending on the country in which you are located, you may need to change the settings before you can
make effective use of Spectrum Expert.

Step5  Select Tools > Settings to change the application settings, if necessary.

Step6  Select the Channel Settings or Monitored Bands buttons at left. See “Console Settings” for more
information.

From here, you can use all the features of Cisco Spectrum Expert Software. See “The Cisco Spectrum
Expert Solution” for more information.

Repairing a “Backwards” Installation
N

Note The Cisco Spectrum Expert Software should be installed before you insert the Sensor card into your
PCMCIA slot.

If you have installed the Sensor card hardware first, the software installation process may not work
correctly and Cisco Spectrum Expert Software may not recognize the Sensor card in your laptop. This
section contains instructions on how to fix this situation, should it arise.

The installation process automatically installs the software drivers required by the Sensor card. If you
install the Sensor card first, the necessary device drivers are not present.

If a message appears indicating that the necessary device drivers are not present, follow these steps:

Step1  Click the Don’t prompt me again to install the software.
Step2  Select Finish.

Step3  Install the Cisco Spectrum Expert Software. See “Installing the Cisco Spectrum Expert Software” for
more information.

After installing the software, Windows XP or Vista may or may not automatically recognize the Sensor
card. Both of these situations are addressed below.

Automatic Hardware Recognition By Windows XP Or Vista

Windows XP or Vista may automatically recognize that the necessary drivers are now present to support
the Sensor card. Windows XP or Vista will install the drivers for you, and you can go ahead and use Cisco
Spectrum Expert Software.

One way to find this out is simply to start the software. If the program starts successfully, this indicates
it has found the Sensor card and it is ready for use.

Another way to check that the drivers are properly installed is to select:

Cisco Spectrum Expert Users Guide
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¢ Start > Settings > Control Panel

¢ Double-click on the System icon.

e Select the Hardware tab.

e On the Hardware tab, select Device Manager.

If the Sensor card—with supporting software drivers—is properly installed, then there will be an icon
for Spectrum analysis devices. Open that icon (double-click on it), and underneath you will see listed
the Cisco Spectrum Expert Sensor. (SAgE is the spectrum-analyzer-on-a-chip in the Sensor card.)

You can close the Device Manager, and get to work with the Cisco Spectrum Expert Software.

Cisco Spectrum Expert Software and Your Laptop

There are several important issues you need to be aware of, in terms of how your laptop interacts with
Cisco Spectrum Expert Software. These are discussed here.

Laptop Resource Utilization

In general, Cisco Spectrum Expert Software is a resource-intensive software, using a relatively large
amount of CPU cycles. In particular, when you are using the Power vs. Time spectrum plot, or the
Device Finder, you can expect that any other softwares running on the laptop will run slowly.

Spurious Signal Detection

Every laptop computer emits RF signals which can be detected by Cisco Spectrum Expert Software.
While we have implemented various algorithms to avoid classifying these as interferers, the signals will
sometimes be classified as continuous interferers and they will always be visible in all the spectrum
plots. This issue is more prevalent when using the Sensor card’s internal antenna.

Upgrading The Cisco Spectrum Expert Software

Note

An upgrade to Cisco Spectrum Expert 3.2 is considered a major upgrade in that during installation any
previous versions of Cisco Spectrum Expert Software are automatically uninstalled, after which, Cisco
Spectrum Expert 3.2 installs as a “fresh” installation. All generated files, such as Spectrum View
configurations, CCF files, screen captures and data exports will be preserved by the upgrade process.
However, local settings such as Bands/Channels selection, default views and alerts configurations will
not be preserved.

Previous versions of Cisco Spectrum Expert Software were Cognio-branded. For example,
Cognio-branded Spectrum Expert 3.1 can be upgraded to Cisco-branded Spectrum Expert 3.2.
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Note

If your computer has an 802.11 interface, it should be enabled in order to detect Wi-Fi devices. If you

are connected to an AP or Ad-Hoc network through the 802.11 interface, you will occasionally see
strong signals on the spectrum plots that are measurements of your own 802.11 transmissions. But as
long as your network transmissions are not excessive, Cisco Spectrum Expert Software will still operate
correctly in the presence of these signals.
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Figure 4-1: The Cisco Spectrum Expert Software

The Cisco Spectrum Expert Software has a Status Bar at the bottom which may be toggled on and off
using View > Status Bar. The Status Bar displays the following information:

e Current antenna in use
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e System uptime
e User band selections
e Current mode—Live, Playback, or Recording.

~

Note  See “Spectrum Recording and Playback” for more information.

Active Device Tree

The Active Device tree shows all access points, Ad-Hoc networks, and interferer devices currently
detected by Cisco Spectrum Expert Software. The tree is normally on display on the left side of the
application, but can be toggled on and off by selecting View > Device Tree. See “Active Device Tree”
for more information.

Cisco Spectrum Expert Software Tabs and Operational Features

These five modes of operation are accessed by selecting any of the five tabs running across the top of the
application display: Spectrum, Spectrum (2), Devices, Channel Summary, and Device Finder. The
following table shows the relationship between the display tabs, and the application’s operational

capabilities:
Table 5-1 Cisco Spectrum Expert Software Operational Features
Display Tab Reference Comments
Spectrum See “Spectrum Each Spectrum tab can display a mixture of Spectrum
Spectrum(2) Tabs, Plots, apd Plots and Charts. Thf% application Provides two
Charts Overview”, |Spectrum tabs, allowing for two different,
“Using Spectrum  |user-configurable, default configurations of Plots and
View Plots”, or Charts.
See “Using
Spectrum View
Charts”.
Devices See “Working Detailed information on detected devices. Unlike the
With Devices Active Devices list, this will also show historical
View”. devices (i.e., devices which are no longer active).
Channel Summary |See “Working with |Summary of RF activity on all monitored channels.
the Channel
Summary”.
Device Finder See “Device Cisco’s “sniffer” for locating unwanted RF devices.
Finder Mode”.

Cisco Spectrum Expert Users Guide
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Control Panel
Several of the viewing modes have specific controls which enable  : cantrol Panel 1 x
you to fine-tune the features of the display. For example, one of | panuency | center Freqispan 3

the Spectrum Plot Controls panel is shown at left. Normally, the

. . . Band 2.4 - 2.5 GHz Band
Control Panel automatically comes into view when you select an
. T T Center 2,450 GHz
appropriate mode, such as Spectrum mode (See “Using Spectrum
Span 100,00 MHz

View Plots”), Devices mode (See “Device Finder Mode”), or
Device Finder (See “Working With Devices View”). =/ Amplitude

f 1 -20 d
e If the Control Panel is not displayed, select View > Control e i

Panel. Select the same menu option to toggle the Control Serbcalacle: R

Panel off. - Trace 1 ®on (I off
¢ Inthe Spectrum view, each plot and chart has its own unique ki M‘.ax =
controls. If the Control Panel is showing but the controls for ~* TFace2 Oon: ©on
the plot or chart of interest are not displayed, click on the plot ~ # Trace3 Oon  @off
or chart of interest. The appropriate controls will then be =l Marker Cion @ off
shown on the Control Panel. Type single
* You can adjust the size of the Control Panel and the Active Thace Ahace]
Devices view by placing the cursor over the line which Walue 2,430 &Hz
divides them, left-click and hold the mouse button, and drag
up or down.

i=I Channels &on ) off
Channels 1,6,11
Show Power  None

Show Devices *) On () Off

Hiding / Unhiding the Active Devices List & Control Panel

You can use options on the View menu to hide or display the Active Devices tree and the Control Panel.
You can also use the mouse to control the display of the Active Devices tree and the Control Panel, as
illustrated here.

Note = We illustrate with the Control Panel, but the techniques apply to the Active Devices tree as well.

Close
You can close the Control Panel or Active Devices tree by Control Panel q
clicking the Close button. S | Corter Freq/span v
Band 2.4 - 2.5 GHz Band
Auto-Hide
You can hide the Control Panel or Active Devices list by .
clicking the Auto-Hide button, which has a small push-pin ipntiolBanel [#]x
symbol on it. - Frequency | Center Freq/Span w |
Band 2.4 - 2.5 GHz Band
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Hiding .the Control Panel allows more room for I e ol
other display features (such as a larger view of the =
. e = spectrum = spectrum (Z)
Spe.ctrum tab shown at rlght). However, a small - ‘ 2 / e Spectn [
vertical Control Panel tab is still shown at left. 5 ‘
a Real Time FFT
>
3 3 3 ;l FoIULGOl LIS, (U uon £

Note If you hover (w1thoqt clicking) the mouse Bl Dt M —

pointer over the vertical tab for the Control 1 Trara % M

Panel, the Control Panel is temporarily
restored to view. This allows you to make changes or make selections on the Active Devices tree.

Note  To restore the Control Panel/Active Devices tree to permanent status on the display, click the
Auto-Hide button.

Menu Options

The Cisco Spectrum Expert Software has the following menu options:

File Menu

The File menu offers the following options:

¢ Open Capture File—Allows you to play back a previously recorded Cisco Capture File. See
“Spectrum Recording and Playback” for more information.

¢ Save Replay As—Captures Instant Replay spectrum data to a Cisco Capture File for later playback.
See “Spectrum Recording and Playback” for more information.

e Instant Replay—Enables a 1 to 60 minute replay of stored running FIFO capture data.

e Record Capture File—Captures spectrum data to a Cisco Capture File for later playback. See
“Spectrum Recording and Playback” for more information.

e Stop Capture File—Terminates the recording of spectrum data.

e Connect To Sensor—Allows you to select a different Sensor card or to open a CSC file.

Note Select the Browse button to locate the CSC file of interest.

Note Some Sensor cards automatically use the external antenna if one is connected, and will override
any contrary setting here.

Note  If you expect to use these settings in the future, check the Automatically Use These Settings
Next Time box.

¢ Import Settings—Allows you to import Local Settings into Spectrum Expert.
¢ Export Settings—Allows you to export Local Settings into Spectrum Expert.

e Exit—Closes the Cisco Spectrum Expert Software.
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View Menu

Spectrum Menu

This menu provides access to most of the main Cisco Spectrum Expert Software features:

Spectrum—Enables you to create a variety of plots and charts which provide real-time views of RF
activity. You can save your configuration of plots and charts. See “Using Spectrum View Plots” for
more information.

Spectrum (2)—The same as with Spectrum; you can create a variety of plots and charts, and save
your configuration.

Devices—Shows all RF devices detected by Cisco Spectrum Expert Software. See “Working With
Devices View” for more information.

Channel Summary—Shows RF activity—such as power levels, and the presence of 802.11 and
interferer devices—on a channel-by-channel basis. See “Working with the Channel Summary” for
more information.

Device Finder—Enables you to track down the location of interfering devices. See “Working With
Device Finder” for more information.

Active Devices—Shows all access points, ad-hoc networks, and interferer devices currently
detected by Cisco Spectrum Expert Software. See “Active Devices” for more information.

Control Panel—Toggles the Control Panel on and off. The Control Panel sets the details of your
view in several different modes: Spectrum View, Devices View, and Device Finder. See “Control
Panel” for more information.

Status Bar—Provides various system status information and user band selections. Use this menu
option to toggle the Status Bar display on or off.

This menu is only visible when the Spectrum or Spectrum (2) tab is selected.

Add Plot—Adds one of the available plot types.
Add Chart—Adds one of the available chart type.

Remove Selected Items—Removes the currently selected plot or chart from the display. (You must
first select a spectrum plot or chart for this menu option to be active.)

Pause Selected Items—Freezes the display of data on the currently selected plot or chart.

Resume Selected Items—Only shown if you first select a plot or chart which was previously
paused. Resumes the real-time update of data for that plot or chart.

Zoom In/OQut—Maximizes or minimizes the size of a selected plot or chart.

Export Selected Items Data—Captures and exports data from a specified spectrum plot or chart
and saves it to a file.

Cut—Deletes the currently selected spectrum plot from the display and pastes it to the clipboard.
Copy—Captures the currently selected plot or chart.

Paste—Retrieves a spectrum plot or chart from the clipboard and pastes it in the display area.
Select All Items—Selects all spectrum plots and charts currently displayed on the spectrum tab.

Open Spectrum View Configuration—Once you have configured plots and charts on one of the
two Spectrum tabs, you can save the plot/chart configuration. This enables you to easily restore the
same configuration at a later time. See “Saving and Restoring Spectrum View Layouts” for more
information.

[ oL-15237-01
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|
e Save Spectrum View Configuration—See “Saving and Restoring Spectrum View Layouts” for
more information.
e New Spectrum View Configuration—See “Saving and Restoring Spectrum View Layouts” for
more information.
See “Using Spectrum View Plots” for more information.
Tools Menu

This menu provides access to the Settings dialog. The Settings dialog has five panels:

See

Help

Sensors and Antennas—Selects which Spectrum Sensor card (and, in some cases, which antenna)
the Cisco Spectrum Expert Software uses for spectrum data acquisition.

Console Settings—Modifies date and time presentation on the Cisco Spectrum Expert Software, the
Spectrum view configuration to use for playback, enables the Instant Replay feature, selects the
Default AP Category (In-Network or Unknown), and the color of the plot’s background.

Band and Channel Settings—This panel determines, by Regulatory Domain (USA, Japan, etc.),
which RF bands and channels are monitored for RF activity and reported on by Cisco Spectrum
Expert Software. The default setting is to monitor the channels indicated on the 802.11b/g Channel
Settings panel. However, there are also options for other pre-defined 802.11a bands, including the
US Public Safety Band and user-selected channels in middle and upper bands as well.

Alert Settings—Used to enable or disable security and performance alerts for an interferer type or
category.
SNMP Option / Cisco WCS Settings
— SNMP Option—Cisco Spectrum Expert Software has an ability to send SNMP traps when it
detects interfering devices. This screen is used to configure the trap filters and threshold levels

that will trigger the sending of an SNMP trap. The Settings — SNMP Option screen is used to
configure the trap filters and threshold levels that will trigger the sending of an SNMP trap.

~

Note The SNMP Option icon appears in the Cisco Spectrum Expert Software standard version.
See “SNMP Option Settings” to configure the SNMP settings.

- WCS Settings—The WCS-enabled Cisco Spectrum Expert Software provides the ability to
send and receive Air Quality (AQ) data using the Cisco proprietary mode of streaming
communication between Cisco Spectrum Expert Software and a Wireless Control System

(WCS). The Settings - Cisco Option screen is used to configure the sending of data to the WCS.

~

Note The WCS Settings icon appears in the Cisco WCS-enabled Cisco Spectrum Expert Software
version. See “WCS Settings” to configure the WCS settings.

“Local Settings Overview” for more information.

Help Topics—Provides access to the Cisco Spectrum Expert Software Help system.

About Cisco Spectrum Expert Software—Provides copyright and version information for the
Cisco Spectrum Expert Software.

About Spectrum Sensor Card—Provides technical data for the Sensor card currently in use.
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e Capture File Properties—This option is active when a CCF file is playing and will display file
information when invoked.

Spectrum Recording and Playback

The Mobile software enables you to record spectrum data in Cisco Spectrum Capture (CSC) files. You
can then play these files back at a later time. Each CSC stores the following information to disk:

~

Note  Cisco Spectrum Capture files are subject to a size limitation of 512 MB. You should estimate CCF file
size growth at a rate of 6MB per hour/per band selected when considering the 512 MB size limitation.

e Active Devices—A list of active devices vs. time, plus all information needed to reproduce the
Devices View and any of its sub views and columns for all monitored bands during playback.
(During playback you will be able to change columns and see meaningful information that changes
with time, just as with live mode.)

¢ Spectrum Plot Data—All information needed to reproduce any of the Spectrum Analyzer plots
(except Power vs. Time and Power vs. Frequency — these plots will not be available during
playback). You can adjust the settings for the other plots and charts during playback.

e Spectrum Chart Data—All information needed to reproduce any of the spectrum charts during
playback.

¢ Reference Information—This includes the date and time of capture, the Windows user/login name,
and the Sensor card revision and serial number.

The diagram at right shows the controls
used for spectrum recording and
playback:

The controls are described briefly below.

¢ Record—Opens a dialog box where
you can define the name and file
location of a CSC file. Upon closing
the dialog box, recording begins | T — Thudenii 162005 | 19618
automatically. You can also initiate
this operation by selecting File ¥ Play
Record Capture File.

Golive  Stop Record
¢ Open—Opens a previously captured fPlayback
CCF file for playback. You can also ot used during Record.)
select File & Open Capture File. Use } M AT S
the Open Capture File dialog box to
select the recording of interest. : 0 Current Time o

e Playback—Once you have opened a
CSC file, select this to start playback.

e Stop—Stops the recording process, and also stops the in-progress playback of a CSC file.
¢ Go Live—Returns you to live mode. Any playback or recording that was in progress is halted.

¢ Slider Control—You can use this control to move to any particular time during the playback
interval.

You may select any combination of Spectrum Analyzer plots or charts during playback.

Cisco Spectrum Expert Users Guide
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Just as in a live spectrum session, you can right-click within the display area to get pop-up menus used to
navigate to specific information. Additionally, you can use all other plot icons and features, such as adding,
moving, zooming, and removing a plot or chart during playback.

~

Note = The Power Vs. Time and Power Vs. Frequency plots are not supported during playback.

Spectrum Instant Replay

The Instant Replay feature allows you to review the most recent spectrum information up to the past 60
minutes, without having to record it in a CCF file, and play it back much as if it were being viewed live
for the first time without interrupting receipt of current spectrum information. Spectrum information of
interest viewed as an Instant Replay may then be saved as Cisco Spectrum Capture (CCF) files to share
information on what is happening in the spectrum.

The screens at right show the two access methods used for Instant Replay.
Filz =] Wiew = Spectrum * Tools =

= Cpen Capture File..,

| Instant Replay |
(=] Record Capture Fils...

=A=][a
Navigate from Tools > Settings > Console Settings to display the Instant Replay
settings options as shown at right. The controls are described briefly below and detailed instructions on
Instant Replay Settings, Initiating an Instant Replay and Converting an Instant Replay to a CCF can be
found in the Online Help.

Enable Instant Replay of the Sensonsand

last—Select to enable the Instant : Antennas i [rate Formats Lsed Throughout the &pplication
Replay function. Mon r\inv i2.16:.lilﬁ:ltllil w
Minutes—Select the length of the
Instant Replay (range 1 to 60
minutes)..

Inskant Replay
- -
e

[“]Enable Instant Replay of the last | 1 ¥ minutes

What If I'm Not Seeing Any Data?

It may happen that you are viewing one of the Cisco Spectrum Expert Software displays, such as a
spectrum plot, but you are not seeing any data; or data is missing for part of a plot. (For example, some
of the channels on the plot have spectrum data, and others do not.) Or, you may know perfectly well that
some kind of interfering device is present in the environment, but the Devices List and/or Device Finder
are not detecting it.

Cisco Spectrum Expert Users Guide
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Sensor Card Not Properly Inserted

One possible cause of this problem could be a complete lack of communication between the Sensor card
and the Cisco Spectrum Expert Software. Normally, however, if communication is lost with the Sensor
card, the Cisco Spectrum Expert Software will present a warning message, and then shut down.

To resolve such problems, check to ensure the Sensor card remains properly seated in the card slot.

Faulty Configuration Settings

Another possibility is that, while you have set your spectrum plots to display certain channels or bands,
your configuration settings for Cisco Spectrum Expert Software as a whole do not include those
channels/bands.

To determine if this is the problem—and to rectify if—you need to check your Channel Settings and
Monitored Bands under the Cisco Spectrum Expert Software’s Settings panel. See “Local Settings
Overview” for more information.

Erroneous Scale Settings

With the spectrum plots (See “Using Spectrum View Plots™), it is possible you may fail to see any data
if you have an amplitude setting that is inappropriate for the actual data being monitored. For example,
suppose you are monitoring the RF duty cycle, and have the vertical axis amplitude set to range from 0%
to 100% (the default setting). If in fact the actual duty cycle values are very low (say, ranging from 0%
to 1% or 2%), you may not see any data.

This can be a particular problem with the Swept Spectrogram plot, where RF power values and duty
cycle values are mapped to colors. If all the measured data falls in a very narrow range compared with
the Color Scale, you may see nothing but a solid block of a single color — in fact, you are seeing the
correct data, but it seems as if you are seeing no data at all.

Selecting the [Auto Scale] option on these plots should normally correct this problem, but sometimes it
helps to manually adjust the measurement scale.

Wrong Antenna Settings

Another possibility is that you may have an internal Sensor card with an external antenna, but you are
using the Sensor card’s internal antenna. (This might account, for instance, for why you might fail to see
some interfering devices you expect to see.) Check your Sensors and Antennas settings. See “Sensors
and Antennas ” for more information.

Miscellaneous Device Issues

There are various RF effects that can prevent or partly hinder device detection. These are discussed in
detail in the “Working With Devices View” section.

Cisco Spectrum Expert Users Guide
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Cisco Spectrum Expert Software Active Devices

Active Devices

The Active Device tree normally displays on the left side of the Cisco Spectrum Expert Software. It
shows access points, Ad-Hocs, and interfering devices if these devices (access points and interferers) are
currently live (transmitting). A tree structure organizes access points together, Ad-Hocs together, and
different types of interfering devices together.

e To view the Device Tree, select View > Active Devices.

i Active Devices 2 x
e If you double-click on a device, a dialog box will appear &=-Wi-Fi Ad Hocs [1] ~
providing more detail on the device including a picture of a hpsatup (Ch &)

=-Wi-Fi APs (In-Mebwork) [93]

typical device that matches the RF signature. (You can also
{0000 ED: 97 :DF:A0) (Ch &)

right-click on the device and select What Is This Device?) -
oo ¢ Find This Device

* Right-click on any interferer device and select Find This Device (00:1¢  Whatis This Device?
to activate the Device Finder. See “Device Finder Mode” for Gt
. . | MEIAT
more information. {00:1¢

| Known
(o1 | oL

Note  The Device Finder can only locate certain types of devices. If S|
you right-click on a device that can't be located, you will not
be able to access the Find This Device option. Also, a device must be currently active
(transmitting) in order to find it. If, in Devices View, you click on a device which is not currently
transmitting, you will not be able to access the Find This Device option..

Current Devices vs. Historical Devices

The Active Devices tree only shows devices which are currently active, or transmitting, during the last
measurement interval.

For an historical list of detected devices—which includes currently active devices, but also devices
which are no longer detected—use the Devices View. See “Working With Devices View” for more
information.

You can also see a pop-up list of active devices by mousing-over the trace area of a Cisco Spectrum
Expert plot.

Cisco Spectrum Expert Users Guide
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Bl Active Devices

Keeping Your Eye On A Particular Device

If there is a particular device that is of interest to you, you can keep an eye on the device simply by
clicking on it. Your selected row will be highlighted.

As new devices are detected (or disappear from view), the Active Devices tree will auto-scroll and
auto-sort. However, Cisco Spectrum Expert Software will make sure that your highlighted row always
remains in view; in other words, auto-scrolling and auto-sorting will be adjusted so that your highlighted
row always remains visible on Cisco Spectrum Expert.

Problem Indicators and Security Alerts

Problematic devices shown in the Active Devices pane are "
highlighted in yellow or red. The colors indicate the interference i File = Miews ~ Spectrum v Tools = Help =
level of active devices. Yellow means the duty cycle of the i Active Devices 2 ox
in.terferer is gregter than 25% and it affects at least ope channe.l - c.;.rd|éss'|=;i-.nﬁes -[1-]- '
with a BSS device. Red means the duty cycle of the interferer is ¥ DECT-Like Base Station 1
greater than 50% and it affects at least one channel with a BSS = Genetic - Continuous [1]
device. Device (T4 @ 2450.00 MHz
. . . . 1= Generic - Fixed-Frequency [1]
Security and alert settings are available and can be configured & Channel Group 1 @ 245568 MHz [1]
using the Settings — Alert window. Once configured, security alert 1, Device 1 £UMKY
icons display in the Active Devices tree when the predefined = Wi-Fi Ad Hos [1]
triggers occur. % hpsetup (Ch 10}
- Wi-Fi APs [7]
05Z405765564 (Ch &)
A A MAFTrR 7103 (TR Y

Active Devices and Devices View

Normally, you do not need to see the Active Devices tree at the same time that you are in Cisco Spectrum
Expert Software’s Devices mode, since in Devices mode you can see all RF devices—both those which
are currently active, and historical devices.

If you select the Devices tab in the main | ge- vew~ oo~ peb- i @ 3] © Wedden 17 13,19
Cisco Spectrum Expert Software ; i Control Panel | [z JRZm@ 7S bevies |
workspace, and select the push-pin on g SLMLWW Devices: Currenily Active, Al Channsls
the Active Devices tree Cisco Spectrum i o ‘
Expert Software hides the Active [ cumently actve v e e | Doy e
Devices tree. However, a small Active Chanre Slection e
Devices tab remains visible at the left allSie A 13 FU;DEQ?)T;?) EEE et 71220 E
side of the display. BosRCA oo (1) o Ve lmn. C
Sermarfonn Whekess (Che) | 2.0 Weddon 7085 1 £

~

Note  You can move the mouse over this tab to bring the Active Devices tree back into view
temporarily. The Devices Control Panel is temporarily hidden behind the Active Devices pane.

If you then click on the push-pin (circled in the illustration at right), on the Active Devices pane, this
puts the Active Devices pane permanently on view. The Devices Control Panel will then still be on
view, but lower down on the left side of the display.
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Active Devices W

You might want Active Devices on view at the same time as Devices mode, as an easy way to distinguish
between currently active devices vs. the more extensive list of devices (active and historical) shown in
Devices mode.

See “Hiding / Unhiding the Active Devices List & Control Panel” for more information.

Exporting Data

The Export Data feature provides additional functionality to the list of active devices in the Active
Devices tree. The Export Data feature allows you to export device information to a file for future
analysis. This option can be accessed by right-clicking on a device in the Active Device tree to display
a pop-up menu.

When Export Selected Data... is selected, a window appears providing a default file name and Save in
location (Spectrum Captures folder). The window also allows user selection of the file name and Save
in location.

Cisco Spectrum Expert Users Guide
[ oL-15237-m .m



Chapter6  Cisco Spectrum Expert Software Active Devices |

Bl Active Devices

Cisco Spectrum Expert Users Guide
m. oL-15237-01 |



_— CHAPTER 7

Working with Spectrum Tabs, Plots, and Charts

Spectrum Tabs, Plots, and Charts Overview

As indicated above, the application provides two spectrum tabs, Spectrum and Spectrum (2). Each tab
operates identically. The application has two tabs so that you can create, name, and save two distinct
configurations of plots and charts. (You can create and save more than two plot/chart configurations; but
you can have two of them as defaults that automatically appear on these tabs.)

Descriptions of the specific charts and plots—including the parameters for fine-tuning the plot/chart
content—may be found in the Online Help, and in “Using Spectrum View Plots” and “Using Spectrum
View Charts” of this manual. Here we provide an overview of how to use these tabs (Spectrum and
Spectrum (2)) to create your custom plot/chart views.

Create A Spectrum Plot or Chart

Step 1

Step 2

Note

To add a spectrum plot or chart, follow these steps:

Right-click in the workspace for the spectrum plots and select
Add Plot > <Plot Type> or Add Chart > <Chart Type>.

You can also use the menu
Spectrum > Add Plot > <Plot Type> or Spectrum > Add Chart > <Chart Type>.

Use the Plot Control panel at the left of the display to set the parameters for the plot or chart. The
particular parameters will vary depending on the type of plot. An overview of the Plot Control panel is
presented in “Spectrum Plot Controls.” Detailed descriptions of chart parameters are also contained in
the Cisco Spectrum Expert Software Online Help system.

Of particular importance for the spectrum plots, and for some of the |2 qrace1  @on  Ooff
charts — in order to see any data displayed at all, you need to select

K X Tvpe Maz
the On button for at least one Trace. A Trace describes the line of
data shown on a plot. = Tracez  ©on  Ooff
Type Ayverage
By default, the Trace or Traces for a plot are set to Off. 3 Oon Boff
Ma:x Hold

e If you are in a Spectrum tab and the Controls are not visible, select View > Control Panel.

| oL-15237-01
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M Create A Spectrum Plot or Chart

e To access the plot Control Panel for a particular plot or chart, simply use the mouse to click on that
plot.

~

Note If you have more than one plot in view, then as you click on different plots, the plot Control
Panel will display the configuration options for the currently selected plot.)

Multiple Plots

You can repeat the instructions immediately above to place more than one plot on display. You can
configure any combination of up to nine plots and charts (in 1024x768 mode or higher), or four plots
and charts (in 800x600 mode) per Spectrum View tab.

Measurement Interval

Unless you have paused a plot (discussed below), the Cisco Spectrum Expert Software updates each plot
or chart once per measurement interval, which is typically once every second.

Pause and Resume Plotting

At times an event may occur in your network, such that you want to immediately capture the RF
environment at that moment for sustained study and review. You can pause and resume plots and charts
by right-clicking in the workspace, and selecting the appropriate menu options, or by selecting these
options from the Spectrum menu (e.g., Spectrum i Select All Items i Pause Selected Items):

¢ Select All Items—Selects all plots/charts displayed in the currently selected Spectrum tab and
enables the Spectrum menu options.

¢ Pause Selected Items—Freezes the data displayed on the currently selected plot(s) or chart(s). (Be
sure to right-click on the appropriate plot/chart when you bring up the context menu.)

¢ Resume Selected Items—Resumes real-time data display for the currently selected plot/chart(s).
¢ Pause Selected Items—Freezes data display on all plots/charts.

¢ Resume Selected Items—Resumes the real-time update of data on all plots/charts.

Copying Plots and Charts

All plots and charts displayed in Spectrum View can be copied and pasted within the pane area of the
window. You can copy and paste a plot or chart using on of the following three methods.

Method 1
Click on the top of the plot frame and hold down the <Ctrl> key. The cursor changes to indicate copy mode.
Move the mouse to the desired location.

Release the mouse button to paste a copy of the plot or chart. The copied plot or chart is subject to total
count checking and PvT/PvF trace limit checking.

Cisco Spectrum Expert Users Guide
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Step 1
Step 2

Step 1

Step 2

Create A Spectrum Plot or Chart W

Method 2

Select a plot.
Press <Ctrl + C>. The selected plot is copied to the clipboard.

Method 3

Right-click on a plot or chart to display the pop-up menu. Or, select Spectrum from the Main menu to
display the drop-down menu.

Select the Copy option. The selected plot is copied to the clipboard.

Pasting Plots and Charts from the Clipboard

Step 1
Step 2
Step 3

Spectrum View plots and charts can be retrieved from the clipboard and pasted into your current
Spectrum View session, an additional Spectrum View session running on your machine, or a different
machine running Cisco Spectrum Expert Software with the same card type. The paste feature is subject
to total plot/chart count checking and PvT/PvF trace limit checking.

To paste a plot from the clipboard, follow these steps:

Open the clipboard and copy the desired plot.

Right-click within the View pane to display the pop-up menu.

Press <Ctrl + V>. The plot gets pasted to the end of the view.

Or, you can paste a plot from the clipboard using the Main menu as follows:
a. Open the clipboard and copy the desired plot.

b. Select Spectrum from the Main menu to display the drop-down menu.

c. Select the Paste option. The plot gets pasted to the end of the view.

Cutting Plots and Charts

Step 1
Step 2

Use any of the following methods to cut a plot or chart:

Method 1

Select a plot.

Press <Ctrl + X>. This removes the plot and copies it to the clipboard.

Method 2

[ oL-15237-01
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Step1  Right-click a plot to display the pop-up menu.
Step2  Select the Cut option. This removes the plot from the display and copies it to the clipboard.

Method 3

Step1  Select a plot.
Step2  Select Spectrum from the Main menu to display the drop-down menu.

Step3  Select the Cut option. This removes the plot from the display and copies it to the clipboard.

Method 4

Step1  Left-click on the plot or chart of interest.
Step2  Press Delete.

Method 5

Step1  Left-click on the X icon located in the upper right-hand corner of the plot or chart.

Method 6

Step1  Left-click on the plot or chart of interest.

Step2  Select Spectrum i Remove Selected Item... from the Main menu to display the drop-down menu.

Moving Plots and Charts

All plots and charts displayed in Spectrum View can be moved within the pane area of the window.

Method 1

Step1  Left-click on the top banner of the plot frame.
Step2  Drag the plot to the desired location. A blinking vertical line indicates the new location.

Step3  Release the mouse button to drop the plot in the new location.

Method 2

Step1  Right-click on the top banner of the plot frame.

Step2  Drag the plot to the desired location. A blinking vertical line indicates the new location.

Cisco Spectrum Expert Users Guide
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Step 3
Step 4

Create A Spectrum Plot or Chart W

Release the mouse button to drop the plot in the new location. A pop-up menu displays.
Select on of the following options:

e Copy Here—pastes a duplicate of the original plot in this location.

e Move Here—relocates the original plot to this location.

¢ Cancel—terminates the operation.

Selecting Multiple Plots and Charts

Zoom In/Qut

Note

Step 1
Step 2

Step 1

Step 2

Step 1
Step 2

Step 3

In cases where you need to perform the same operation on more than one plot or chart, multiple plots
and charts can be selected. For example, you may want to remove, pause, or resume more than one plot
at the same time.

When multiple plots and charts are selected, the control panel displays a message indicating that
Multiple items are selected and no controls are available for configuring plots and charts.

Multiple plots and charts can be selected as follows:

Hold down the <Ctrl> key.
Left-click each plot to select it.

For optimal viewing, a plot or chart can be maximized (zoom in) and minimized (zoom out) to its
original size. A plot or chart in Zoom In mode is indicated by an orange background. Additionally, you
can zoom in/out on up to two plots or charts at the same time.

To zoom in/out a single plot, follow these steps:

Double-click, or right-click, the frame or left click the magnifying glass icon of the plot to maximize it.
The orange background indicates Zoom In mode.

Double-click the frame or left-click the magnifying glass icon to minimize it.

Or, use the View menu to zoom in/out:

Select a plot.

Select Spectrum from the Main menu to display the drop-down menu. Or, right-click within the View
pane to display the pop-up menu.

Select the Zoom In option to maximize the plot. Or, select Zoom Out to minimize it.

To zoom in/out multiple (up to two) plots, follow these steps:

[ oL-15237-01
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Step 1
Step 2

Step 1
Step 2
Step 3

Step 4

Hold down the <Ctrl> key.

Double-click the frame of each plot to maximize them. Or, double-click each frame to minimize them.

Or, use the View menu to zoom in/out multiple plots:

Hold down the <Ctrl> key.
Select the plots.

Select Spectrum from the Main menu to display the drop-down menu. Or, right-click within the View
pane to display the pop-up menu.

Select the Zoom In option to maximize the plot. Or, select Zoom Out to minimize it.

Saving and Restoring Spectrum View Layouts

Note

Step 1

Step 2

Other operations are available for working with plots and charts. The operations Open Spectrum View
Configuration..., Save Spectrum View Configuration..., and New Spectrum View Configuration
can all be selected from the Spectrum menu. Remove Selected Items... can be selected from the
Spectrum menu.

All these operations can also be selected by right-clicking on the frame of a plot or chart, and selecting
from the context menu that appears.

¢ Save Spectrum View Configuration—Enables you to save the current configuration of open plots
and charts, including their specific display parameters. (The current data, however, is not saved.)

In the Save Spectrum View Configuration dialog, type in the name for your configuration, or select the
name of a previously defined configuration.

~

Note  The name you type here will also appear on the Spectrum and Spectrum(2) tabs, so we suggest

ELINT3

you use something short but descriptive, for example, “Plots Only”, “Charts Only”, “Duty Cycle
Charts and Plot”, “Devices and RF Power”, etc.

To make the current configuration be the default configuration, be sure to first select the Set as startup
default for this view check box. If you select this, the current configuration will appear every time you
log into the Cisco Spectrum Expert Software, and select the current tab.

~

Note  You can save a separate default view for each Spectrum tab.

Select [OK] to save or Cancel to exit without saving changes..

¢ Open Spectrum View Configuration...—The dialog box for this operation will list all of your
currently saved spectrum views. Select one view, and then select OK.

¢ New Spectrum View Configuration—This operation clears all currently displayed plots.
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e Remove Selected Items...—This operation will close only the currently selected plot.

Deleting A Spectrum View

Step 1

Step 2
Step 3
Step 4

To delete a saved spectrum view, follow these steps:

Create A Spectrum Plot or Chart

Right-click on the Plots workspace and select Save Spectrum View Configuration..., or —

Select File > Save Spectrum View Configuration.

In the Save Spectrum View Configuration dialog, select an existing view.

Then select Remove Saved Configuration.

Select OK on the confirmation dialog box.

Exporting Data

The Export Data feature provides additional functionality to all Spectrum plots and charts, as well as
the active devices listed in the Active Devices tree. This feature allows you to export device information
to a file for future analysis. This option can be accessed by right-clicking on a device name, on any plot
or chart, or anywhere in the display pane to display a pop-up menu.

When Export Selected Data... is selected, a window appears providing a default file name and Save in
location (Spectrum Captures folder). The window also allows user selection of the file name and Save

in location. A sample exported data file for an Interference Power chart is as follows:

Table 7-1

Interference Power

Interference Power

Vertical Scale:

Channel

WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.
WiFi Ch.

O 0 3 O L B W N~

—_
—_—

10 dBm/

In-Network Wi-Fi AP
-85

-90

Max Interference
-78.6
-78.6
-78.6
-78.6
-78.6
-78.6
-78.6
-78.6
-78.6
-78.6
-78.6

Cordless Phones
-81.2
-81.2
-81.2
-81.2
-81.2
-81.2
-81.2
-81.2
-81.2
-81.2
-81.2

Wi-Fi CCI

-85

-87

Wi-Fi ACI

-82.4
-80.1
-74.9
-70.9
-88

-70.7
-70.2
-65.8
-62
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Spectrum Plots

The Spectrum Plots use graphical displays to provide detailed, low-level views of the RF spectrum. The
plots are based on data from the SAgE chip embedded in the Sensor card. (SAZE is Cisco’s spectrum
analyzer on-a-chip, containing advanced, on-board support for real-time processing of spectrum data.)
In this section we explain the information displayed in each plot.

~

Note  For information on Spectrum Charts, see “Using Spectrum View Plots.”

Using Spectrum View Plots

For information on creating spectrum plots, pausing and resuming the display, and saving plot
configurations, see “Spectrum Tabs, Plots, and Charts Overview.” For information on how to fine-tune
data displays for each plot, see “Spectrum Plot Controls.”

Plot Content

Spectrum View offers five different types of plots. We list all five plots here, and provide more detailed
discussion in the following pages. You can view a tooltip list of active devices by mousing-over the trace
area of a Cisco Cisco Spectrum Expert Software plot. More information is available in the Online Help.

Frequency-Based Plots

There are four plots which offer different views of RF power as a function of frequency. For these plots,
the entire plot is updated once per measurement interval (approximately once per second):

e Real Time FFT Plot
e Power vs. Frequency
e FFT Duty Cycle

¢ Swept Spectrogram—Combines a time- and frequency-based view of the RF spectrum.

Time-Based Plot

This plot shows the variation of an RF metric over time.

Cisco Spectrum Expert Users Guide
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e Power vs. Time—Plots data based on short time intervals (milliseconds). Mainly used for pulse
detection.

Real-Time FFT Plot

A Real-Time FFT plot displays RF power as a function of frequency—a Fourier transform of the RF
spectrum. The data is direct data from SAgE. The plot can provide three different views: the average
power (Avg) read during the most recent measurement interval; the maximum power (Max); or the
maximum power detected at any time since the plot began running (Max Hold). This plot can also
display the integrated channel power for each RF channel in RTFFT plots on a trace-by-trace basis by
selecting the Channels On radio button in the Control Panel and using the Show Power drop-down box
to select which channel trace should display the Integrated Channel Power.

Note  Integrated Channel Power is the sum of all the signals present in an RF channel. Signals are added in the
mw domain and the sum is converted to dBm for display. Integrated Channel Power is disabled when
user selects “None” from the combo box. By default, the channel power of Trace 1 is displayed. The text
color of Integrated Channel Power is the same as the color of the corresponding trace data. Integrated
Channel Power is viewable only when RF channel bars are displayed.

See “The Real-Time FFT Plot Compared with the Power vs. Frequency Plot” for more information.

Power vs. Frequency

The Power vs. Frequency plot is also a Fourier transform of the RF spectrum, showing the amount of
RF power detected at various frequencies. The difference between this plot and the Real-Time FFT plot
is that the Power vs. Frequency plot is generated based on an analysis of SAgE data. This means that
data can be aggregated and combined in various ways that are not possible with direct SAgE data, the
basis for the Real-Time FFT plot. This plot can also display the integrated channel power for each RF
channel in RTFFT plots on a trace-by-trace basis by selecting the Channels On radio button in the
Control Panel and use the Show Power drop-down combo box to select which channel trace should
display the Integrated Channel Power. Four spectrum plots are shown below.

Figure 8-1 Power vs. Frequency, Real Time FFT, FFT Duty Cycle, Swept Spectrogram

Real Time FFT n3ax FFT Duty Cycle n2ax

Center: 2.450 GHz Span:100.00 MHz Center: 2 450 GHz Span: 100.00 MHz
Yertical Scale: 10 dBm / RBW:156.25 kHz Vertical Scale: 10% / RBW:156.25 kHz
[CTrace 1: Max I Trace 2: Average ClTrace 1 MawG Sweeps B Trace 2 Off
/T 3 0K Off

Power Vs. Frequency n2ax Swept Spectrogram n7ax
Center: 2.450 GHz Span: 100.00MHz Center: 2 450 GHz Span: 100,00 MHz

Vertical Scale: 10 dBm / RBW:£25 00 kHz Sweep Time: 1 secs RBW- 156 26 kHz
[Trace 1: Free Run, Nomal B Trace 2: Off [CTrace 1: Max

[ Trace 0K -14 dEmp
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~

Note  The highlighted plot (with an orange background) is the current selected plot. To pause the selected plot,
click Spectrum > Pause Selected Items.

FFT Duty Cycle
The FFT Duty Cycle plot displays the percentage of the time that the ambient RF signal is 20 dB above
the noise floor. (This is represented on a per-frequency bin basis.) The Duty Cycle for the FFT Duty
Cycle plot includes all RF energy, both from 802.11 devices and interferers.

Swept Spectrogram

The Swept Spectrogram is a different presentation of the data shown in the Real Time FFT and FFT
Duty Cycle plots. Each colored horizontal line in the Swept Spectrogram plot displays the RF power
or duty cycle as a function of frequency, as measured over the time period of one sweep in time (typically
one second). The power or duty cycle values in each sweep are mapped to a range of colors, and
displayed in a scrolling or "waterfall" display. This allows you to observe the FFT signals over historical
time, and easily see signals with shifting frequencies and various durations. (You select between the
power or duty cycle metrics using the Control Panel.)

See “Interpreting The Swept Spectrogram Plot” for more information.

Note  The color legend for the Swept Spectrogram is only displayed if there is enough room on screen.
Depending on your display resolution, and on how many plots you have open at once, you may need to
close some other plots in order to see the mapping of colors to power levels.

Power vs. Time

The Power vs. Time plot displays RF power as a function of time. The time scales involved are very
brief—microseconds or milliseconds—so the plot is mainly used to observe RF pulse activity.

The Real-Time FFT Plot Compared with the Power vs. Frequency Plot

Figure 8-2 Real Time FFT Compared to Power Vs. Frequency
Real Time FFT 17 x Power V5. Frequency n7ax
Center: 2 450 GHz Span: 100.00 MHz Center: 2 450 GHz Span: 100.00 MHz
Wertical Scale: 10 dBm / RBW:156.25 kHz Vertical Scale:10 dBm / RBW:£25.00 kHz
[dTrace 1: Max I Trace 2: Average [ Trace 1: Free Run, Mormal I Trace 2 OFff
[ Trace 3: Off [ Trace 3: Off

-20dBm T T T o T T T =i T 1 =20 dBm |

70 dBm [

120 dBm

2,400 GHz

Both the Real-Time FFT plot and the Power vs. Frequency plot show RF power as a function of
frequency, at a given moment in time. However, the two plots differ in important respects:

Cisco Spectrum Expert Users Guide
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Table 8-1

Real Time FFT Comparted to Power Vs. Frequency Plots

Property

Real Time FFT Plot

Power Vs. Frequency Plot

Data Source

SAgE Hardware—Raw spectrum
data is collected on the SAgE chip
inside the Sensor card. Statistical
analysis is performed directly by
SAgE’s onboard hardware. This
enables very fast analysis of large
quantities of spectrum data, but with
the limitation that the parameters of
the analysis are hard-coded into the
design of the SAZE chip.

SAgE plus Microprocessor
Software—Raw spectrum data is provided
by the SAgE chip in the Sensor card and is
then analyzed by software running on the
CPU inside the laptop.

This software analysis of the spectrum data
provides greater flexibility in the analysis,
but with the trade-off that less data can be
analyzed in a given time frame.

Dwells

FFT analysis is performed on only 20 MHz of the band at one time. Each 20 MHz
span is referred to as a dwell. By measuring several successive, adjacent dwells, it
is possible to construct a plot which is essentially similar to a Fourier transform of
the entire band (2.4 GHz, 5 GHz, 900 MHz, etc.).

Bins and Bin

Each 20 MHz dwell is divided into

With advanced software analysis, the number

Sizes 128 bins, where each binis 156 KHz |of bins, and the bandwidth of each bin, is
wide. A power measurement is user-defined, so you can achieve much finer
provided for each bin. The number |granularity in your power measurements.
of bins, and the bandwidth of each |For example, a single bin can be as narrow as
bin, is fixed. about 9.7 KHz. To get the number of bins

(data points on the plot); divide the span
being measured by the RBW. For example, a
20 MHz span, with an RBW of about 20
KHz, will have about 1000 points (bins) on
the plot.

Number of FFTs |The Real-Time FFT Plot is updated |The software-based Power vs. Frequency

Per Plot once per second. Each plot is calculations generate only one FFT per
actually an average over the 5000 second. That one FFT is shown in the Power
FFTs performed by SAgE during vs. Frequency plot (which is updated once
each dwell. per second, to reflect the new FFT).

If you have set the plot to show an Average
over all FFTs, the calculation is based on an
average of several preceding FFTs that were
plotted; but each successive second in real
time only contributes one new FFT to that
average!.

Max Mode One of the plotting options is to A maximum power plot cannot be created,

display the maximum RF power
seen during the measurement
interval. This is possible because the
maximum power can be selected
from among the 5000 FFTs.

because actual data is available for only one
FFT per second (rather than having data for
5000 FFTs, as with the real-time plot).

[l Cisco Spectrum Expert Users Guide
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Property

Real Time FFT Plot

Power Vs. Frequency Plot

Advantage of
Using This Plot

Because the plot shows an average
of all 5000 FFT measurements made
by SAgE in a second, you are more
likely to see spectrum results from
devices that are frequency hoppers,
or bursty transmitters.

You can achieve much finer control over the
granularity of the spectra that you see.

Disadvantage of
Using This Plot

You cannot control the granularity
of the spectrum.

Since you only see one FFT for the entire
one-second measurement interval, you are
less likely to see either frequency hoppers or
bursty devices.

Playback Mode

This plot can be played back
historically, as well as viewed in real
time.

This plot can only be viewed in real time, not
historically.

Primary
Application

The primary use of this plot is for
looking at broad RF spectrum
activity, covering an entire band.
This is useful for tasks like site
surveys and initial network
deployment.

The primary use of this plot is for

trouble-

shooting, particularly for identifying

and analyzing the spectrum behavior of an
unknown interferer. It is often most effective
when looking at less than a full band.

1. This footnote applies to Power vs. Frequency plots only, and not to the
Real-Time FFTs. When you create the Power vs. Frequency plot, the very first
plot shows a single FFT. And—again, assuming the plot is set to be in “Averaging”
mode—the second plot adds one new FFT, and averages that with the FFT from the
first plot. Each second, one more FFT is added to the average. However — the
average is not performed over all preceding FFTs, but only for a more limited
number, those included in a process known as “video averaging.”

Interpreting The Swept Spectrogram Plot

This section provides an illustrated discussion of interpreting the visual display in the Swept
Spectrogram plot. Color coding is used to indicate intensity of either RF power or RF duty cycle
(depending on which you choose to plot, using the Spectrum Plot Controls panel).

110 dBm 2

-37 dBm

Figure 7-2: Swept Spectrogram Color Mappings For RF Power (top) and Duty Cycle (bottom)

Shown here is a comparison of how the same RF power
measurements might look if plotted using a standard line

graph—with the height of the graph indicating RF

power—compared to using colors on a straight line as a
means to indicate power levels. Here, blue is less power,

yellow is more power, red is the most power..

RF
Power
2.4 GHz 2.5 GHz
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Time T = 1 This is the very first sweep you would

see on starting the plot. It represents the RF power S_“{gip
(average power, or maximum power, or duty cycle

power, per your selection), as a function of

frequency — and at the present moment.

The amount of power at each frequency is
represented through the color coding scheme.

SweepOL____ ° IS S—|
2.4 GHz 2.5 GHz

Time T = 2 In the next measurement interval (typically  sweep
one second later), the previous measurement “slides Sl
up” one level, becoming sweep —1.

A new sweep, representing “now”, replaces it at the
bottom, becoming the new sweep 0.

Sweep -1 [
Sweep 0 I

2.4 GHz 2.5GHz

Time T = n We continue, measurement interval after  Sweep
measurement interval, with older measurements of RF 164
power sliding up, and the latest “now” appearing at the
bottom. By mentally visualizing a vertical “slice” of

the graph, you can see how the power levels have

changed at a selected frequency going back in time.

(The UP arrow points from the present to the past.)

Sweep 0
24 GHz 2.5GHz

What If No Data Is Showing?

The section on “What If I'm Not Seeing Any Data?” discusses several potential reasons that you may
see no data, or appear to be seeing no data, in Cisco Spectrum Expert Software. We repeat here, in
summary form, one particular issue unique to the spectrum plots: incorrect amplitude settings.

With spectrum plots, you may fail to see any data if the range of the amplitude setting, the lowest and
highest power values shown on the plot, is inappropriate for the actual data being monitored. This can
be a problem with any of the plots, but particularly with the Swept Spectrogram, where RF power
values and duty cycle values are mapped to colors. If all the measured data falls in a very narrow range
compared with the Color Scale, you may see nothing but a solid block of a single color — in fact, you
are seeing the correct data, but it seems as if you are seeing no data at all.

Selecting the [Auto Scale] option on these plots should normally correct this problem, but sometimes it
helps to play manually with the measurement scale. See “Amplitude” for more information.

Spectrum Plot Controls

The plot Control Panel lets you fine-tune the data presented by the plots. Each plot has its own
plot-appropriate controls. However, many of these controls are common to more than one plot. We
discuss the typical controls here. The online help fills in additional plot-specific details.

Cisco Spectrum Expert Users Guide
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Frequency and Bandwidth To Monitor

Amplitude

Note

Several plots provide measurements of RF power (average power, i control Panel o x
maximum power, etc.) as a function of frequency. The RF . = Frequency |Center Freq/Span 3|
frequencies are presented as a range across the horizontal axis. R W\
Frequency settings enable you to establish the range of X-axis. Start/Skop Freq

Even for the time-based plots, however, you can still set the band Benter By.Charinel

and/or channel that Cisco Spectrum Expert Software will monitor. Span 100,00 MHz

You can select the frequency to be monitored based on a Center Frequency and Span, or based on a
Start/Stop frequency, or based on specific Channels. You then use the Band/Channel drop-down menu
to select a particular Band or Channel to monitor.

Once you have made a selection, the application automatically fills in default values for the Center
frequency and Span, or the Start and Stop frequency. However, you can edit these default values.

e If you change the default Center frequency and frequency Span, or the Start and Stop frequencies,
you may no longer be plotting entirely “in channel” or “in band.” However, Cisco Spectrum Expert
Software will NOT permit you to set frequencies that are outside the hardware capabilities of the
Sensor card technology. In this sense, the technology is “error proof™.

* You can change the bands available here—that is, the bands shown on the Frequency menus—by
changing the Monitored Bands settings (Tools > Settings > Monitored Bands). See “Monitoring”
for more information.

¢ You can change the channels available here by changing your Channel Settings (Tools > Settings
> Channel Settings). See “Band And Channel Settings” for more information.

Cisco Spectrum Expert Software will only make available, for selection here, those channels which you
have selected under Channel Settings, provided those channels also fall within the bands you have
selected under Monitored Bands.

Bandwidth — The Power vs. Frequency plot also has a Bandwidth
setting, which determines the size of each bin for RF power
measurements. See “Power vs. Frequency” for more information.

- Bandwidth [ ] Auto Select
REW 156.3 kHz

Amplitude settings enable you to set the scale for the vertical axis. 5 Amplitude
The exact measurements will depend on the type of measurement
being made. For example, RF power measurements are in dBm, while
duty cycle measurements are in percentages (since the duty cycle is Wertical Scale 10 dB f

typically defined as the percentage of time an RF signal is above some

threshold value; or the percentage of time an RF signal is detected from a network device or interferer).

Reference Le -20 dBm

¢ Reference Level refers to the value at the top of the vertical axis.

e Vertical Scale refers to the change in value represented by each tic-mark on the vertical axis.

| oL-15237-01
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Trace Settings

Markers

In general, the bottom of the scale is
Reference Level — (10 * Vertical Scale).

Example: If the Reference Level is -25 dBm, and
the Vertical Scale is set to 5 dBm, then the top of
the scale is -25 dBm, while the bottom of the scale
is -25 dBm — (10 * 8 dBm) = -105 dBm.

Auto Scale - If you select [Auto Scale] the
application automatically selects the optimum
calibration for the vertical scale, based on recent
power measurements.

-65 dBm

-105 dBm

A Trace is the line which actually plots the RF data of interest.

¢ You must select the On radio button for at least one Trace, in

order to see any data at all.

e For some plots, you can have more than one Trace, and you can
select the type of data each trace displays (such as Average RF

-25 dBm

AN
o, r".' I’ Il'l
|"'I ‘|_I |'F IIII

y

:
i
0

]l'| ‘Lmli

Start: 2.400 GHz

= Trace 1
Tvpe

= Trace 2
Tvpe

- Trace 3

power, Maximum RF power, Max Hold RF power, Max - §
Sweeps, etc.). The Online Help describes these options in detail.

e Max Hold maintains a display of the highest RF power measured
since you began the current session. The [Clear] button deletes
the Max Hold Trace, and starts a new maximum power trace, starting from the moment when

[Clear] is selected.

W
iR
“ LA
Lo

{;‘ on
Max

() 0n
Maxx Hold
®on  Ooff

Average B

) off

I off

A marker is a small icon on the plot which “rides” the graph at a particular point along the X-axis, in
other words, at a particular frequency. The marker moves up and down according to the movement of the
graph at that fixed point. The marker is the small red box riding the bottom trace in the plot shown here:

e On/ Off—Indicates whether the marker is on or off, that is, in

use at all.

¢ Type—A Single marker is just that, one marker that
“rides” the trace. If you select Delta, you will initially
still see a single marker on the plot. However—with a
quick “mouse hand”—you can grab the marker with
your mouse pointer (click and hold on the marker),
and slide the marker to a second location on the plot.
You now have two markers riding the trace, so that
you can see the difference in behavior between two
different frequencies.

e Trace—For plots that allow more than one trace, use
the drop-down list box to select which of the traces
the marker will ride.

Cisco Spectrum Expert Users Guide

=l Marker 1
Type
Trace
Yalue

Peak Search

Real Time FFT

Center: 2.452 GHz
Vertical Scale: 10 dBm /
[ Trace 1: Max
[ Trace 3 Max Hold

CMarker 1R: NAA

-20dBm T

-120cdBm -

CMarker 1:

@on (o

Single E]
Trace 1

2,450 GHz

nrax

Span: 2203 MHz
RBW:156.25 kHz

I Trace 2 Average

#=2.450 GHz
''=-46.0 dBm
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e Value — Indicates where along the X-axis (the frequency or time axis) the marker should ride the
plot.

Moving The Marker With The Mouse—You can indicate the frequency value using the Value text box.
However, once the marker is visible on screen, you can grab the marker (click and hold the left mouse
button), and drag the marker to a new location (a new frequency or time).

Peak Search—With the marker Peak Search mode, the plot is continually updated with the value of the
peak marker as the spectrum plot is traced to identify the peak during each cycle. This feature is
selectable for both Single and Delta markers and works with RTFFT, FFT Duty Cycle, and PvF spectrum
plot functions. Peak Search is selectable for the highest peak, next peak up, next peak down, next peak
left, and next peak right.

. .* Highest Peak
.t Next Peak Up
.+ Next Peak Down
e+ Next Peak Left

e —* Next Peak Right

Setting The X-Axis Position of Delta Markers

For more extensive instructions on setting the X-axis position of dual markers, see the Cisco Spectrum
Expert Online Help, in particular the topic Setting Marker Positions.

Channels
Some of the spectrum plots use frequency values [EELEL
on the horizontal axis. On these plots you have, | _i i_ i_
as an option, the ability to superimpose
bracketed indicators of channels. I J| lH"W I
-B5 dBm ll‘ " ]
I i
[
|1 I Irf"'llrlf\‘|
“cm H Ch5u ’| eh ol cn't
| iH tH
-105 dBm
Start: 2.400 GHz
You can turn the display On or Off using the 15 Ghanneie "@on  Ooff
Channels radio buttons. The channels shown will be the ones BT I E]
appropriate for the band you are currently monitoring, taking into T o
account any Regulatory Domains you have selected under Channel R
: . . . Show Device|1, 4, 5, 11
Settings. See “Band And Channel Settings” for more information. ;—M
1,6, 11, 14
. . 2,7, 12
Show Devices —The On and Off radio buttons allow you to enable or 3,10, 14
disable the display of devices associated with each channel as you
mouse over the frequency trace in a plot.
>
Note  Even if you turn on the Channels indicators, they will only be shown if fully within the span of the plot.
Cisco Spectrum Expert Users Guide
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Other Plot Control Panel Settings

Power vs. Time

Note

Note

The Power Vs. Time plot is used to display short burst of RF activity, known as “pulses”.

¢ Sweep Time—This sets the time scale over which pulse activity is measured. Specifically, it sets
the range of the X-axis, which will run from a low value of —Sweep Time up to the present. You can
use the spin control to change the setting, or type in a value directly. Type “ms” for microseconds
and “us” for milliseconds. For example: 150 us.

The plot also has a specialized Bandwidth setting:

e RBW-—Determines the span of the spectrum monitored for power. This works in conjunction with
the Center Frequency setting for the same plot. The low end of the monitored band is Center
Frequency — RBW/2, and the high end is Center Frequency + RBW/2.

This is not the same definition for RBW that applies for the Power vs. Frequency plot (discussed
below), where RBW sets the bin size for the X-axis.

The Power vs. Time plot also has a series of Trigger settings. Trigger criteria determine both what
kinds of RF pulses are displayed, and when the display is updated.

e Trigger Type—This determines when the plot is updated.

¢ Free Run—RF energy (in your selected bandwidth) is sampled on a continuous basis, and data is
“dumped” to the screen as it is available. This means the display is updated on a nearly constant
basis, and data is shown whether or not any RF pulses are detected.

¢ Single—This catches a single pulse only. The display is only updated when an RF pulse is detected
which matches your Trigger Threshold criteria (discussed below). If you select Single, you must
then click on [Arm] (discussed below).

e Once such a pulse event is detected, it is displayed on the plot, and the plot is then frozen — no further
activity is displayed. To catch any further pulses, you click again on [Arm].

e Continuous—The plot is only updated when Cisco Spectrum Expert Software detects RF pulses
which match your Trigger Threshold criteria. However, after detecting a pulse, the plot
automatically “re-arms” itself, meaning every time a new pulse comes along, the plot is updated with
new data. (Once again, of course, the pulses are only shown if they also fall within the bandwidth
you have indicated, using the options above.)

e [Arm]—If you have selected a Trigger Type of Single, select [Arm] to tell the Cisco Spectrum
Expert Software to be on the lookout for the next pulse that comes along.

e Trigger Threshold—This indicates the minimum power that an RF pulse must attain in order to
register as a pulse, for purposes of this plot. Put another way: In order to be counted as a pulse at
all, for purposes of this plot, an RF pulse must exceed the amount of power you indicate here. Units
are in dBm, where 0 dBm is equivalent to 1 milliwatt.

For example, if you indicate -10 dBm, then a pulse which reaches -5 dBm will be displayed, while a pulse
whose maximum power is only -12 dBm will not be displayed.

Once the trigger line is shown on screen (as a white horizontal line), you can also change the setting by
clicking-and-holding on the line with the mouse, and dragging it up or down. The current Threshold is
displayed on the plot, just above the line.
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e Trigger Delay—This adjusts the centering of a pulse on your display. The default value is 0, and
with this setting the beginning of an RF pulse is always centered on the midline of the time axis. If
you set this to a positive value, the beginning of the RF pulse is offset to the left. If you set this to a
negative value, the beginning of the pulse is offset to the right.

e Power Vs. Frequency Plot Bandwidth—The Power vs. Frequency plot has a Bandwidth setting,
which determines the size of each bin for RF power measurements. A "bin" is the smallest span of
spectrum for which power measurements are displayed.

e Auto Select—If you select this check box, Cisco Spectrum Expert Software automatically picks the
optimum bin size. The value selected by the application will vary depending on the total bandwidth
you choose to measure (using the Frequency settings).

¢ RBW-—RBW stands for "resolution bandwidth". Effectively, the bin sizes for RF power
measurements will be just slightly larger than the value that you enter here. (So, for example, if you
enter 60 kHz, your bins will be roughly 70 to 90 kHz wide.) You can only enter a value here if you
first de-select the Auto Select check box.

~

Note  This is not the same definition for RBW that applies for the Power vs. Time plot (discussed
above), where RBW sets the size of the total bandwidth being monitored.

When you enter a value for RBW for the Power vs. Frequency plot, Cisco Spectrum Expert Software
may "auto-adjust” your entry to the nearest valid value. The formal definition of RBW is the 3 dB
bandwidth of the spectrum analyzer detection filter. The RBW determines the minimum frequency
spacing that is allowed between two pure frequencies, in order for the frequencies to actually be
distinguished as separate signals.

Example: If RBW is set to 70 kHz, then two signals which are separated by only 60 kHz in frequency
will appear as one signal, with a combined power measurement for both signals.

¢ Total Number of Bins—The total number of bins is approximately the Span being monitored
divided by the RBW.

For example, if a 100 MHz span of the spectrum is being viewed—and if that span is divided into
bins of 2 MHz in size—then the plot displays 50 separate power readings, indicating the power
detected in each separate 2 MHz bin.

Note = The minimum number of bins is never less than 16, and the maximum number of bins on the plot
is at most 1024. If you try to establish settings for the Span and RBW which would cause higher
or lower bin values, Cisco Spectrum Expert Software will auto-adjust the RBW or Span setting
to bring the number of bins within the allowed range.

The Power Vs. Frequency plot also has a series of Trigger settings, similar to those for Power Vs.
Time:
¢ Trigger Type—This determines when the plot is updated. Use the drop-down list box to select one
of the three options.

— Free Run—RF energy (in your selected bandwidth) is sampled on a continuous basis, and data
is “dumped” to the screen as it is available.

- Single—The display is only updated when RF energy is detected which matches your Trigger
Threshold criteria (discussed below). If you select Single, you must then click on [Arm]
(discussed below).

— Once such RF energy is detected, it is displayed on the plot, and the plot is then frozen — no
further activity is displayed. To catch any further activity, you click again on [Arm].

[ oL-15237-01
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Swept Spectrogram

Note

FFT Duty Cycle Plot

— Continuous—The plot is only updated when Cisco Spectrum Expert Software detects RF
energy which matches your Trigger Threshold criteria. However, the plot automatically
“re-arms” itself, meaning every time a RF energy comes along which exceeds the Trigger
Threshold, the plot is updated with new data.

e [Arm]—If you have selected a Trigger Type of Single, select [Arm] to tell the Cisco Spectrum
Expert Software to be on the lookout for the RF energy which exceeds your Trigger Threshold.

e Trigger Threshold—This indicates the minimum RF power must be seen in order to update the plot.
Units are in dBm, where 0 dBm is equivalent to 1 milliwatt.

For example, if you indicate -10 dBm, then RF energy which reaches -5 dBm will cause the display
to be updated, while RF energy below -10 dBm does not result in any update.

~

Note  Using The Mouse—Once the trigger line is shown on screen (as a white horizontal line), you
can also change the setting by clicking-and-holding on the line with the mouse, and dragging it
up or down. The current Threshold is displayed on the plot, just above the line.

The Swept Spectrogram plot uses colors to represent RF power levels. The Color Scale options enable
you to map the “highest color” and “lowest color” to specific power levels.

<-110 dBm [ -110 dBEm -30 B > -30 dBrr!

Here, the color Blue has been mapped to -110 dBm, while Red has been mapped to -30 dBm.

Values below the minimum value (-1.10 dBm, in this case) are g tolor Scale \uto Seald
automatically mapped to Purple, while values above the

i ~ Maxd -30de
maximum value (-30 dBm here) are automatically mapped to. gallell m

Mirirnm -110 dBm

Color Scale Visibility: For the Swept Spectrogram, the color scale is only visible when there is enough
room to display it on screen. Depending on how many plots you have open, and on your display monitor
resolution, you may need to close some plots to see the color scale.

[Auto Scale] serves the same purpose as elsewhere — it chooses appropriate upper- and lower-values
based on recent power measurements.

For the FFT Duty Cycle plot, the scale of the Y-axis is based on a Maximum and Minimum, where
(typically) the Maximum would be 100%, and the Minimum would be 0%.
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Spectrum Charts

The Cisco Spectrum Expert Spectrum Charts use bar, line, and pie charts to provide broad summary
information about activity in the RF spectrum. Like the spectrum plots, the spectrum charts are based on
data from the SAgE chip embedded in the Sensor card. In this section we explain the kinds of
information displayed in each graph.

Using Spectrum View Charts

For a discussion of creating charts, pausing/resuming the display, and saving chart configurations, see
“Spectrum Tabs, Plots, and Charts Overview.”

~

Note  Spectrum Plots are discussed in “Using Spectrum View Plots.”

Chart Content

Spectrum View offers seven different types of charts. We list all charts here, and provide more detailed
discussion in the following pages.

e Active Devices

e Devices vs. Channels

e Devices vs. Time

e Channel Utilization

e Channel Utilization vs. Time
e Interference Power

¢ SNR

Active Devices

A pie chart which indicates—via different sized “slices” of the pie—what percentage of your RF activity
is coming from different kinds of RF sources. You select which channel / band to monitor.

Cisco Spectrum Expert Users Guide
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Devices vs. Channels

A bar chart displays the number of devices detected on different channels. You can select which
frequency bands or channels will be monitored.

Devices vs. Time

A line chart displays the number of devices detected at different times. You can select the time interval
of interest (ranging from ten minutes up to 24 hours), the channel or band to monitor, and the types of
devices which will be tracked on the plot.

Channel Utilization

A bar chart displays RF duty cycle as a function of channel activity. You can select which frequency bands
or channels will be plotted.

Channel Utilization vs. Time

A line chart displays RF duty cycle as a function of time. You can select the time interval of interest
(ranging from ten minutes up to 24 hours), and the channel or band to monitor.

For longer time intervals, you can also select how data is aggregated — that is, you can track the average
duty cycle, the maximum duty cycle, or the minimum duty cycle.

Figure 8-1: Spectrum Charts

P T =l
Channel Utilization 178 x Channel Utilization ¥s. Time n7&Ex
Yertical Scale:10% / Yertical Scale: 10% / Interval: 10 minutes
Ml Generic - Fived-Freque... E'Wi-Fi/Other Bl Trace 1: WiFiCh. 1, AVG [ Trace 2 'WiFi Ch. B, AVG

[ Trace 3: WiFiCh. 11 AVG I Trace 4: OIff
1003 24-25GHz Band
100 %
a0 % 50
- - = ———
0% 0% T T T T T T T T T
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Interference Power

A bar chart that shows the power for each selected channel. The height of the bar shows the maximum
power of all interference signals. Each bar consists of several lines representing the signal strength of a
specific device type. The receive signal strength of the strongest In-Network Wi-Fi access point on each
channel is shown by a + (plus) sign. The Wi-Fi noise floor is represented by a horizontal line across the
grid background.

Figure 9-1 Interference Power Chart for Wi-Fi
Interference Power n7ex
Yertical Scale: 10 dBm / + In-Metwark Wi-Fi AP
Il Generic - Fixed-Freque... EIWi-Fi ACI 'wi-Fi Moize Floor
0 dBm

2.4 -25GHz Band

S50 oBm eke— B +

=100 ciBmn T T T T T T T T T T T |

The X-axis shows the channels, and the Y-axis shows the signal strength (from -100 dBm to O dBm). The
height of the bar indicates the cumulative power (in dBm) for all devices in this category that affect a
given channel.

To view channel and power information:

e Place the mouse to hover over a stacked bar to view pop-up information about the channel,
maximum power, and the signal strength of each interfering device. Or, place the mouse to hover
over a + sign to view pop-up information about the channel and the signal strength of the strongest
In-Network Wi-Fi access point.

¢ Right-click either a stacked bar or + sign to view the same pop-up menu available on the Devices
vs. Channel chart.

| oL-15237-01

Cisco Spectrum Expert Users Guide g



Chapter9  Spectrum Charts |

M Using Spectrum View Charts

SNR (Signal To Noise Ratio)

A color coded bar chart that displays the SNR T
SNR for each channel having access points. | Vertical Scale:10d8 /

SNR is the ratio of a given transmitted 508 24-25GHzBand

signal to the background noise on the

channel.

The X-axis shows the channels and the
Y-axis shows the SNR power level (from
-50 dB to 50 dB). The height of the bar
above or depth of the bar below the 0 dB
line indicates the SNR (in dB) for a given
channel.

-a0 dB T T T T T T T T T T

Bar Indicators

¢ On the Channel Utilization, Devices vs. Channel, and Interference Power charts the colored bars
indicate the power level for each channel. Each interfering device is represented by a different color.
A legend showing the devices and their associated colors is located at the top of the screen.
Consequently, each colored section of the graphed bars map to the device legend.

e The height of the bar shows the maximum power of all interference signals. Each color segment
shows the contribution of a specific device type to the maximum power.

On the Interference Power chart, the receive signal strength of the strongest In-Network Wi-Fi access point
of each channel is represented by a + (plus) sign.

Navigate to Other Views

The bars and graphs on certain charts allow you to obtain additional information on a particular channel.
You can navigate from Spectrum View to Devices or Channel Summary View. On the following
plots/charts: Channel Utilization, Devices vs. Channel, Real Time FFT, FFT Duty Cycle, Swept
Spectrogram, and Power vs. Frequency right-click on a channel bar (or anywhere in the workspace of
the plot) to display the pop-up menu. Select Show Devices Affecting <channel ID> to display the active
devices in Devices View. Select Show Channel <channel ID> to display related data on this channel
(highlighted in blue) in Channel Summary View. The Real Time FFT can also display the integrated
channel power for each RF channel.

Chart Controls

The chart Control Panel lets you fine-tune the data presented by the charts.
Concerning band and channel selections, first note the following:

* You can change the bands available here—that is, the bands shown on the Channel menus—by
changing the Monitored Bands settings (Tools > Settings > Monitored Bands). See “Band And
Channel Settings” for more information.

Cisco Spectrum Expert Users Guide
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* You can change the channels available here by changing your Channel Settings
(Tools > Settings > Channel Settings). See “Band And Channel Settings” for more information.

S

Note  Cisco Spectrum Expert Software will only make available, for selection here, those channels
which you have selected under Channel Settings, provided those channels also fall within the
bands you have selected under Monitored Bands. (In other words, the available channels are
determined by the intersection of your Channel Settings and Monitored Bands.)

Channel or Band Selection For Channel-Based Charts

Charts which use the RF channel as the independent variable (on the X-axis) include the Channel
Utilization chart and the Devices Vs. Channel chart. These charts enable you to select exactly which
channels will be displayed on the chart.

For each band supported by your product, a drop-down list box enables you to select one of three options:

¢ All Channels—All channels in the band will be charted.

Control Panel a1 x

e Channel Range—If you select this option, you then select a From | 24-2.50Channel Range |
channel (the lower end of a range) and a To channel (the upper end of  From
the range) using the drop-down list boxes.

_hannel Range
To Mone

¢ None—None of the channels in the band are charted.

Note  You may need to click on the [+] tree control buttons to expand visible options for each band displayed
on the Control Panel.

The Active Devices plot, which is a pie chart, has no X-axis. The pie
chart simply shows the distribution of different device types in a selected
band or channel. The single, simple Channel drop-down list box lets you

select which channel or band is reported on by the chart. i ,
To

i Control Panel ‘F

= 2.4 - 2.5 [ Channel Range

'>.[D:..<.. r

[ == RN e T, ERCR VIR -

WiFi Ch,

o
<

Selection Options for Time-Based Charts

The Devices vs. Time and Channel Utilization vs. Time charts both use time as the independent
(X-axis) variable. The two plots have similar, but slightly different controls.

Cisco Spectrum Expert Users Guide
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For Devices vs. Time, you can select: ! Control Panel a x
e Interval—The total time interval for the X-axis. For example, if = Metric
you select 8 hours, the chart will indicate display the numbers of Interval 10 minutes
devices seen over time period extending from “now” back to “now Fhanga WiFi o, 1
minutes 8 hours.” i G on O)off
e Channel—Use the Channel list-box to select which channel or Category &l Devices

band to monitor.

Trace—The chart can show usages for up to four different types
of devices at one time. For each of the four traces (represented as different colors on the chart), you
have the following options:

On / Off—Indicates if the trace is in use at all.

Category—Indicate the type of device to be tracked by the trace. Options will vary depending on
your edition of Cisco Spectrum Expert Software, but may include 802.11 devices, microwave ovens,
cordless phones, etc.

Aggregation—For time intervals of 8 hours or 24 hours, each “point” on the plot actually spans a
significant period of time in its own right. You can select whether, for each point on the plot, you
are seeing the Average number of devices active in that time interval; the Maximum number of
devices seen in that time interval; or the Minimum number of devices seen in the time interval.

For shorter total time intervals (4 hours or less), this option is not available. For these shorter
time-frames, each point on the plot represents a short enough period of time that there is no reason to
distinguish between the minimum/maximum/average number of devices. The average value is shown

automatically.
For Channel Utilization vs. Time, you can select: :
: Control Panel 1 x
Interval—The total time interval for the X-axis. For S Metric
example, if you select 8 hours, the chart will indicate [
Interval 10 minutes

display the numbers of devices seen over time period
extending from “now” back to “now minutes 8 hours.” S Tracet  ©on Ooff

Trace—Here, each trace, rather than corresponding to a Claonel  paiEyGhed

device type, corresponds to a band/channel, and/or to a
different type of data aggregation. The chart can show up to = Tracez  ®on  (Ooff
four different tra(.:es at a time. For each of the four traces channel WiFi Ch. 6
(represented as different colors on the chart), you have the
following options: -

. ) o =l Traced  ®on (Ooff
On / Off—Indicates if the trace is in use at all. o

Channel WiFi Ch, 11

Channel—Use the Channel list-box to select which

channel or band to monitor.

Aggregation—For time intervals of 8 hours or 24 hours, each “point” on the plot spans a significant
period of time. You can select whether, for each point on the plot, you are seeing the Average duty
cycle in that time interval; the Maximum duty cycle; or the Minimum duty cycle.

For shorter total time intervals (4 hours or less), this option is not available. For these shorter
time-frames, each point on the plot represents a short enough period of time that there is no reason to
distinguish between the minimum/maximum/average duty cycle. The average value is shown
automatically.
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Devices View

The Devices View shows detailed statistics for each device, including both currently active devices and
historical devices. Devices listed here include both network devices and interferers.

You access this view by selecting the Devices tab. The data in Devices View is organized in tabular form.
(The following list of fields is provisional, and subject to change without notice.)

e Device—The name of the interfering device.

e Signal Strength (dBm)—Average received signal strength (log average) for pulses from the device.
¢ Duty Cycle (%)—Measured duty cycle for this device

¢ Discovery Time—When the device was first detected

¢ On Time—Amount of time the device has been on since it was detected

e Channels Affected—Channels affected by transmissions from this device

e Network ID —Network address for this device, if available (for example, the BSSID for 802.11
device, or the piconet address for Bluetooth devices)

¢ Device ID—The device address for the device, if available. Examples would be the MAC address
for 802.11 access points, the device address for Bluetooth devices, etc.

If there is more than one instances of a device type, the number of instances will be indicated in brackets
(for example, [5]) in the Device Name field.

Figure 10-1 Devices View
Spectrum " Specktrum {2) = Channel & .
I a0 ||:E Spec An =, Devices 5ummar'_.r ?R Device Finder
Devices: Currently Active, All Channels
Signal | Duty
Strength | Cycle Channels
Device ' £ (dBm) (%) "% | Discovery Time On Time | Affected Metwork, ID Device ID
[=1 Wi-Fi &Ps (In-Metvwork) [70]
{00:0D:ED:97:DF: A0 (ChE)  -70.0 Tue Wov 13 11:..  00:00:30  5.11  00:0D:ED:G7:DF:AD  O0:0CED:S7:DF
(00:13:5F:0E:CB:20) (Ch 11)  -B1.0 Tue Mow 13 10:,,.  00:14:30 a.13 00:13:5F:0E:CB:20  00:13:5F:0E:CE:
{00 16:9C48:CCi21) (Che)  -70.0 Tuehov 13 10:,.,  OWO&1S 3.9 00169CH4ECC2L 00:16:9C48:CC
(00:16:9C48:CCi22) (Che) | -69.0 TueMov 13 11:,,  OMO345 3.9 001690450022 00:16:9C48:CC
{00:16:9C:48:D:E0) (Ch 11} -85.0 Tue Mov 1311, 00:03:45 913 00:16:9C:45:D9ED  00:16:9C:48:09
(00:16:9C:48:DREL) (Ch 11} -89.0 Tue Mov 13 11:.. 000145 1012 0016:9CH5:DHEL | 00 16:9C 48:09

In the default view, all of the columns do not display. You can add or delete columns. For more
information see “Adjusting The Column Display.”

| oL-15237-01
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Working With Devices View

Devices View and the Active Devices Panel

Normally, when the Devices View is in the foreground, Cisco Spectrum Expert Software automatically
hides the Active Devices panel. However, you can have both Devices View and the Active Devices panel
on display at the same time. See “Active Devices” for more information.

Adjusting The Column Display

¢ Resize Columns—You can resize the columns by using the mouse to select the dividing line
between columns, and sliding the line to the left or right.

¢ Change Column Order—You can change the order of columns by left-clicking-and-holding on a
column heading, and dragging the column to the left or right. (This works exactly the same as
moving columns in the Windows Explorer.)

~

Note  The Device Name column is always the first column when viewing in the Tree View. You cannot
switch the placement of this column.

e Add or Delete Columns—Not all of the available columns needs be on display at one time. In fact,
in the default view, several columns are normally omitted.

* You can add any of the available columns by right-clicking on the column headings. From the
pop-up menu, select Add Column f <column name>.

¢ You can delete a column by right-clicking on any column heading. From the pop-up menu, select
Remove Column.

¢ Saving The Current Column Settings— Your current column settings are automatically saved
when you exit the Cisco Spectrum Expert Software.

¢ Restore The Default Column Settings—You can restore the default column configuration by
right-clicking on the column headings. From the pop-up menu, select Use Default Column
Settings.

¢ Column Definitions—To obtain a definition for any column, hover the mouse pointer over the
column heading. A definition for that column heading appears in a tooltip window.

Selecting The Display Type

There are two viewing modes available in Devices View.

e Tree View—In this view, devices in column one (Device Name) are organized hierarchically, first
under a device type heading, then under a network master (for example, access point, base station)
heading. This is the default view after start-up. The following device type headings apply for the
tree view:

- Wi-Fi APs (In Network) (Wi-Fi product only)
- Wi-Fi APs (Known) (Wi-Fi product only)

— Wi-Fi APs (Unknown) (Wi-Fi product only)
— Wi-Fi Ad-Hocs (Wi-Fi product only)

— Bluetooth Piconets

Cisco Spectrum Expert Users Guide
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— Cordless Phones
— Microwave Ovens
— Continuous Transmitters
— Burst Transmitters
— Chirp Transmitters
e List View—In this view, there is no hierarchical organization for Device Name data.
A

Note In the default List View the Device Name column is not the first column, a new column,
Categories, appears first.

You can switch between these two viewing modes by selecting the Tree View or List View radio buttons
in the Device Controls panel at the left side of the application. (If the Device Controls panel is not
showing, select View > Control Panel.)

Setting The Time Range

You can set the time range and channel for which devices will e o x
be listed by using the drop-down list box on the Device

Controls panel. (3) Tree Yiew

() Lisk Wi
Devices Historic Range:

| Currently Active -

Channel Selection:

All Channels w

Sorting The Display

You can sort the data in the Devices View by any of the column headings.

e Primary Sort Column—The primary sort is invoked by left-clicking on the column heading. The
primary sort column is indicated with a single tick-mark.

¢ Secondary Sort Column—The secondary sort is invoked by shift-clicking on a column heading.
The secondary sort column is indicated with a double-tick mark.

The sorts do not affect the outline headings in the Device Name column (the first column) for the
hierarchical viewing mode; for this mode the sort is applied only to the data at the lowest level in the
hierarchy for each outline heading. The default sort order is:

e Primary—Device (ascending)

¢ Secondary—Duty Cycle (descending)

Ascending and Descending Sort Order

For any given column, you can toggle between ascending sort order and descending order simply by
clicking on the column heading. (If the column is currently sorted in ascending order, clicking once sets
it to descending order; clicking again restores it to ascending order.)
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This works exactly the same for the secondary sort column — repeated shift-clicking toggles between
ascending and descending order.

Keeping Your Eye On A Particular Device

If there is a particular device that is of interest to you, you can keep an eye on the device simply by
clicking on it. Your selected row will be highlighted. As new devices as detected (or disappear from
view), the Device List will auto-scroll and auto-sort. However, Cisco Spectrum Expert Software will
make sure your highlighted row always remains in view. (In other words, auto-scrolling and auto-sorting
will be adjusted so that the highlighted row always remains visible on Cisco Spectrum Expert Software.)

Locating A Device

The Cisco Spectrum Expert Software’s Device Finder mode enables you to use your laptop as a “sniffer”
to track down a specific interfering device. Device Finder is discussed in detail in “Device Finder
Mode.”

Tip To get started, you can right-click on any interfering device shown in the Devices View. Assuming the
device is currently transmitting, you can select Find This Device from the pop-up menu. This starts the
Device Finder mode. If the selected device is not currently active, the Find This Device option will be
grayed out.

Note  The Device Finder can only locate certain types of devices. If you right-click on a device that can't be
located, you will not be able to access the Find This Device option. Also, a device must be currently
active (transmitting) in order to find it. If, in Devices View, you click on a device which is not currently
transmitting, you will not be able to access the Find This Device option..

Obtaining Detailed Information On A Device

To obtain detailed information for any device, double-click on the device in the list. A pop-up dialog box
appears showing detailed information for that device.

Miscellaneous Device Issues

This section describes miscellaneous issues that affect data displayed in the Device View.

Signal Bounce and Fading

Narrowband signals—such as signals from analog FM cordless phones or analog video cameras—are
prone to “fading.” Signals naturally fade (grow weaker) with increased distance from an RF signal
source. But as a technical term, “fading” refers to the fact that as a signal travels; it bounces and reflects
off of multiple surfaces. So, at some distance from a single source, that single source of RF power results
in multiple signals (all from the same source) crisscrossing each other.

When a single RF signal—reflected from multiple directions—crosses paths with itself, the result is signal
interference. Signal interference can be constructive (resulting in a stronger signal at a given point), or
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Near/Far Effect

destructive (resulting in a weaker signal, or even no signal, at a distance not at all far from the original
source).

The result is that, at a given receiving antenna, the signal can vary greatly in power when the antenna is
moved just a few inches in any direction. To further complicate matters: As people and other objects in the
environment move, the source signal is reflected differently. So even if the receiving antenna stays in one
place, signal strength can vary unpredictably over time.

As a result, when Cisco Spectrum Expert Software is detecting a narrowband interferer, the detection status
may toggle on and off due to fading. Fading occurs in most indoor environments, and the fluctuations in
received signal level are typically correlated to the rate of motion for nearby people/objects.

The presence of strong signals may further impair the ability of the classification software to detect
weaker signals. This is the so-called near/far effect, which is caused when the strong and weak signals
use up the limited dynamic range of the receiver. (In other words, the receiver can only handle so much
signal strength, in total, at one time. So if the receiver is getting two signals, the strong one can
essentially swamp the weaker one.)

Example: When you walk near one cordless phone while you are simultaneously listening to another
cordless phone that’s far away (for example, at your next-door neighbor’s house), you may find that you
lose the weaker signal. When you turn off the near-by cordless phone, you may find that you can detect
the weaker signal again.

These effects cannot be removed by Cisco Spectrum Expert Software. The only thing we can do is make
you aware of them, so that you can understand why it is that certain interferers fade in and out of view
at times.

Device Detection Time

In general, the time required for Cisco Spectrum Expert Software to detect and classify devices, and
reclassify their status if they go from being On to Off, will vary depending on the RF environment and
location of devices relative to Sensor card. In general most devices (other than 802.11) should take on
the order of 5 to 30 seconds. However, 802.11a/b/g devices and 802.11 frequency hoppers may take as
long as ten minutes to be detected.

[ oL-15237-01
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Channel Summary

The Channel Summary shows specific levels of RF activity, such as average power and maximum
power, and whether or not interferers are present, on a channel-by-channel basis. This information is
very helpful in determining whether channel reallocations might improve your network performance.

Figure 11-1 Channel Summary
= Spectrum ﬂ Spectrum (2) ‘\ Devi !J Channel Devi
Im A [iE Spec An My EXIEES J Summary Efq ExiL
Center In-M etwork, AP
Frequency W1-Fi Channel hax Power | Interference In-Metwark | Known | Unknown

Channel £ [MHz] Fresent? | Utiization [%] [dBm] [dBm] SMR [dB] APz APz APz

1 2412 - 1 -B5.0 -A1.0 16.0 11 1 1

2 2417 - 1 -80.0 -B6.0 -25.0 2 1] 1]

3 2422 - 1 -85.0 -B7.0 -28.0 3 1 1

4 2427 « 1 -61.0 -51.0 -10.0 1 1] 1]

g 2432 1 R -47.0 R 1 1 1

G 2437 - 1] -A47.0 -E6.0 12.0 24 1] 1]

7 2442 1 R -47.0 RN 1] 1 1

a 2447 - 1] 0.0 -51.0 -13.0 1 1] 1]

9 2452 1] R -B6.0 R 1 1] 1]

Working with the Channel Summary

To access the Channel Summary, select the Channel Summary tab or select View > Channel
Summary.

Sorting the Display

You can sort the display by any of the columns, simply by clicking on the column heading.

Channel Data

The following data is presented for each channel:
e Channel—The channel number. (The display is sorted by channel number by default.)

¢ Center Frequency—The center frequency of the channel, in MHz.
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e  Wi-Fi Present? (Wi-Fi edition only)—A check mark () in this field indicates that Cisco Spectrum
Expert Software detected activity by an 802.11 device during the last measurement interval.

e Channel Utilization (% )—The current duty cycle of RF activity in that channel. In this case, the
percentage of the time that some signal was present in the channel during the last measurement
interval.

¢ In-Network AP Max Power (dBm)—The maximum power level (in dBm) of the strongest
In-Network Wi-Fi (802.11) device on the channel.

¢ Interference ({Bm)—Power level (in dBm) of the maximum interference on the channel (including
Wi-Fi interference).

¢ SNR (dB)—The signal to noise ratio’s, expressed in dB, for each channel having access points
present.

¢ In-Network AP(s)—The number of Wi-Fi ACI’s identified as being in the network transmitting on
the channel.

¢ Known APs—Network devices (access points) impacting your network, but which are not actually
part of your network (e.g., access points from neighboring Wi-Fi networks).

e Unknown APs —Access points designated as not belonging to the network and not belonging to a
nearby network. Unknown access points should be treated as potential rogues.

¢ Interferers—The number of non-Wi-Fi devices transmitting on the channel.

¢ Ad hocs—The number of access points, belonging to a temporary (Ad hoc) network, transmitting
on your network channel (not displayed by default).

Miscellaneous Channel Summary Issues

802.11 Detection Sensitivity

The threshold for Cisco Spectrum Expert Software to detect 802.11 devices is an RF power of
approximately -80 dBm. This detection sensitivity is commensurate to that of a reliable 54 Mbps connection,
so the detection range is less than 150ft at 2.4GHz and less than 100ft at 5GHz in an indoor environment. In
a large environment users should take detection measurements at several representative locations to cover
entire area 802.11. See the Cisco Spectrum Expert Software release notes for more information.

802.11 Device Types

When Cisco Spectrum Expert Software indicates that an 802.11 a/b/g signal is present on a channel, this
may or may not indicate an access point or network in use. It could also be a zero config client (a station
not currently affiliated with a network) which is transmitting probes, as it seeks out a network.
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Device Finder

In Device Finder mode, Cisco Spectrum Expert Software acts as a lightweight portable probe which enables
you to quickly track down the location of a specific interfering device. Essentially, your Cisco Spectrum
Expert Software-enabled laptop acts as a wireless “sniffer.”

Device Finder Mode

- . . g g
Here we presept asummary description of hoW to put Device Fln.der I | idemy | oy
to work. Detailed instructions are presented in the next subsection. “wi-Fi 4Ps (In-Metwark) [91]
. . . . 0007856 $i(chel | 7an ||
e From the Devices View or the Active Devices tree, select the {00:0:ED:97:0F 4 Find This Device
device that you wish to locate. (O0:OF: 3048 BB \hat iz This Device?
{00;13:5F:0E: Rz
e Carry the Cisco Spectrum Expert system to different locations — (00:16:3C:45:CC:0  Unknown
in the network environment. (BO:16:9CHBICE -  cerwary
{00:16:9C:48:D9:E
. . (00:16:9C 4p:Fae ¥ [Mrhetwork
* At each location, use Cisco Spectrum Expert Software to o0 16 5 BUEE
. . . . . ' . . Ewrmmvk Misk=
measure the signal strength from the device of interest.
=] spectrum == Spectrum {2} - : Channel . : =
W‘E ol ( S I’ Devices ( S //0 Device Finder
Target Signal: (00:186:9C:48:CC:22] [Ch B]
; : R Signal Strenath
Time Since Last Update: 0 seconds
Last Update Time: Tue Mow 1311:44:32
= Signal Strength History 0 dBm—
-20 dBm—
-4l dBm—
gf 60 dBm—
% Iax Strength [dBm): —
a e 80 dBm—
Cur. Strength [dBm):
: _g [ :] 100 dBm—|
-76+ 0
120 dBm—)
Time [minutes)
Measurerent Log L Record Signal ] [ Clear Log ]
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B Working With Device Finder

e Using these signal strength measurements, identify when you are closer to—and further from—the
device of interest. Essentially, the signal strengths indicate when you are “getting warmer” or
“getting colder” in terms of getting near to the signal source of interest.

Based on these measurements, you can then home in on the location of the intruding device.

* You can also use the Measurement Log to record RF signal strength levels at specific locations. If
the “hotter/colder” approach is proving problematic—which may happen if, for example, the signal
is intermittent—the log keeps a record of where different RF levels were recorded. You can use this
information, possibly with the help of a map of your network space, to triangulate the location of
the interfering device.

Working With Device Finder

To use the Device Finder, follow these steps:

Step 1 In Devices View, or on the Active Devices tree, select the device ——— . "E';B':;” ;:;f,:)
you wish to locate. Then right-click on the device name, and select “wi-Fi aFs fIn-Netwark) [91]
Find This Device from the pop-up menu. ' Wz I

{00:00:ED:97:0F:¢  Find This Device
(00:0F: 34:46 B8:6  \What is This Device?
{00;13:5F:0E: R =

(00:16:9C:48:CC: 1 Unknown
(00:16;9C 48 CC:
[00:16:9C 4809 E
{00:16:9C:4B:F8:5
(001690 90ER ] mmmvk Fioke

Krnown
v In-Metwork

Step2  The device is now listed in the Device Finder.
Targst Signal: 052405765564 [Ch 6] - 052405765564 [Ch €

Time Since Lazt Update: 1 seconds
Lazt Update Time: SunJan 21 16:20:00

slep 3 The Signal Strength Target Signal: 052405765564 (Ch B] - 052405765564 (Ch &]
1 Time Since Last Update: 1 seconds fionalstenghy
HlStf)ry graph ShOV.VS a Last Update Time: Sun Jan 21 16:20:00
mOVIHg plot Of the Slgnal R Signal Strength Histary U dBm—‘

strength. This plot oy
makes it easy to 2
visualize when you are
walking towards or
away from the signal
source.

| The black box around one of the bars on the meter
2 indicates the strongest signal stength that has
| been detected Up to the current morment in time.

-40 dBim—

60 dBm— =——

Max Strength (dBm]:
59+0 -80 dBm—

Power (dBm)

= An increase in signal strength
B indicates a high probability that |
you are mowing closer to the device ‘ -0+ 0

Cur. Strength [dBm]:
-100 dBrn—

-120 dBm—
"

Time [minutes)

S

Note  The plot does not automatically reset if the signal is lost.

The Rx Signal Strength meter also provides a real-time indicator of the signal strength from the device
of interest, and is an additional tool in determining whether you are “getting warmer” or “getting colder”
in terms of tracking down the interfering device.
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At moments, you will record a signal of special interest. The signal may suddenly peak or drop off; or
you may be systematically recording the signal at carefully planned locations.

Step4  To maintain a record of the signal of interest, select the Record Inica Sign%ﬂ [ Bl ]
Signal] button, or press the <Spacebar>. -

Cisco Spectrum Expert Software records the Measurement Log
current signal strength and the time in the

.. Time Dregcription Rx dBm

Measurement Log. For a Description, 04:2833PM  [West Atrion] | 47 +0
Cisco Spectrum Expert Software uses the 042541 PM  South Conference Room 46+ 0
: 03:51:43 P E ast Conference Room dE+ (]
device name as a default value. 035022 M North Conference Faom 450
034920 Pr Baze Station 1 - Conference Room -5+

Step5  Type in a description of where the measurement was taken. Press the <Enter> key on your keyboard to
confirm your description.

Step6  You can also edit the location information in the Measurement Log at a later time.
Simply double-click on the description and then key in your new description; then press <Enter>.
(Pressing <Esc> cancels any changes you are making.)

Additional Device Finder Features

The Device Finder has the following additional features and capabilities:

¢ Stop Finding— You can stop tracking the interferer by selecting
the [Stop Finding] button. It is a good idea to do this after you
have found the interferer of interest, since it reduces the drain
on system processing resources.

i Control Panel R ox

[ Reset Signal Averaging ]

[ Clear all Measurements ]

¢ Reset Signal Averaging—If you select the [Reset Signal
Averaging] button, Cisco Spectrum Expert Software no long [
uses prior signal values to calculate the average signal strength.
Instead, Cisco Spectrum Expert Software only calculates
average signal strength from "now" forward, where "now" is when you select [Reset Signal
Averaging].

Stop Finding ]

If you are moving around—or changing the orientation of a directional antenna—this command will
cause the signal averaging measurement to restart, so you don’t display data that may be
representative of the prior position/orientation. A great deal of filtering is applied to provide
accurate measurements, and this can help Cisco Spectrum Expert Software to respond more quickly,
and not be biased from prior measurements.

¢ Clear Signal Strength History—Select the Clear button over the Rx Signal

Strength History plot to clear the plot. Clear [:

¢ Clear Measurement Log—You can clear the Measurement Log of
all data by selecting the Clear Log button above the log. |_Record Signal | | ClearLog %J

¢ Delete A Single Log Entry—You can also delete an individual
row from the Measurement Log. Simply select the entry, and
then press the <Del> key on your keyboard. Then select Yes in the confirmation dialog box.
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¢ Reset Maximum Signal Strength—If you select [Reset

Max], Cisco Spectrum Expert Software deletes the current b Strength [dBm):

value for the maximum signal strength; Cisco Spectrum Gl .80 dBrri—]

Expert Software then ascertains, starting from "now", the Cur. Strength [dBm:

maximum interferer signal strength measured from this time 4450

forward. Loty
— Reset Max only clears the Max Strength text box, and —

the black rectangular box in the vertical signal meter that
indicates the highest strength seen. Use the [Clear] button
(above) to clear the plot.

“Divide And Conquer” Search Strategy

Omni Antenna

~

Note

Step 1

To minimize your effort, and maximize your chances of locating the interferer, we recommend that you
use a “divide and conquer” search strategy (also known as “rectangular bisection”). We illustrate the
strategy, first with the omni antenna, and then using the directional antenna. To use this process, you will
greatly benefit from using a physical map of your network space.

It is possible to hit a “blind spot” when using Device Finder. This is a location—typically a corner of a
large building—where you may not get any measurements at all. If you find you are spending more than
30 seconds at any one spot, without getting an updated device reading, you should move away from that
spot and try a different location.

For purposes of simplicity, assume that your interfering device is located somewhere within a large
rectangular office space (which might measure, for example, 50 by 150°).

Go to each of the far corners of the office space, and measure the signal strength from the interfering
device of interest. Take note of which corner of the office yields the highest signal strength. (A printed
map of your office space can be helpful for jotting down data.)

=l -86 dBm

Stage 1: Using the omnidirectional
antenna, measurements are made from
the four corners of the search area.
-86 dBm 70dBm | -

e

SPRIShR
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Note  Each time you move the Cisco Spectrum Expert system to a new location, select the [Reset

Signal Averaging] button on the Device Finder. Then, at each test location, wait for the
confidence level to settle to a small value—ideally less than +3 dBm, but certainly less than £5
dBm—before recording the signal strength.

Max Strength (dBm]:
-48+1

Reset Signal Averaging Cur. Strength (dBm;
A3

First... Select this each  Control Panel 2 x

time you move to a new
location, to reset the
signal averaging.

Second... This is the confidence level —

once at a new location (and after resetting

the signal averaging), wait until it is a small
value before recording a measurement.

It should certainly be less than + 5 dBm.

Step2  Inthe corner which has the largest signal strength, map out a rectangular sub-search area comprising one
quarter of the total office space.

e i

' |
' |
|- 54 dBm 60 dBm = |
' |
' |
= =
155 ﬁ ﬁ = 1
I _48dBm 60 dBm = |

Stage 2: Repeat the same process, only now using one-quarter of
the original search area. The quadrant to use is the one that had the
highest power measurement in the previous stage. (Here, the size
of the quadrant is exaggerated for purposes of illustration.)

Step3  Repeat this process, as necessary to localize your measurement.

=L

Il ) Socam 52dBm = |
|

ol

" > -48 dBm -42 dBm

Stages 3 through N: Repeat the process again, once more using
one quarter of the original search area, with one vertex at the
location of the highest previous measurement.

[ oL-15237-01
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Step 4

By repeating this process, you will be able to home in on the location of the interfering device.

I
I
I
I
I
I
I
I
-l

Final Stage: When you have reached a sufficiently localized search area, it may prove
effective to simply search on a grid basis—that is, repeated measurements at relatively
brief intervals—until the strongest readings have clearly identified the location of the
interfering device.

Directional Antenna

Step 1

Step 2

Step 3
Step 4

It is possible to hit a “blind spot” when using Device Finder. This is a location—typically a corner of a
large building—where you may not get any measurements at all. If you find you are spending more than
30 seconds at any one spot, without getting an updated device reading, you should move away from that
spot and try a different location.

The advantage of using the directional antenna is that you can save yourself a substantial amount of
walking, because four measurements at a time can be made from one central location. See “Directional
Antenna” for more information.

Once again, assuming a rectangular office space, take your Cisco Spectrum Expert Software laptop to
the center of the office space. Use the directional antenna, with Device Finder, to determine the signal
strength coming from your interferer, as measured in each of four directions. For each measurement, the
antenna should be pointed towards each of the four corners of the office.

~

Note

Again, here, each time you point the antenna in a new direction—as well as when you move to
anew location—select the [Reset Signal Averaging] button on the Device Finder. Then, wait for
the confidence level to settle to a small value (at most +4 dBm) before recording the signal
strength.

Once again, map out a rectangular sub-search area comprising one quarter of the total office space for
the corner which has the largest signal strength.. Again, you only need to make measurements from one
spot, pointing the antenna towards four different directions.

Repeat, again making measurements in the quadrant with the highest power reading.

Once again, you will learn from experience whether the final measurements are best made by a continued
process of rectangular bisection, or whether the final measurements should be made on a systematic grid
of a local area.

[l Cisco Spectrum Expert Users Guide
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Detecting Narrowband Devices

Interfering devices fall into two RF categories, narrowband and wideband. By the very nature of
wideband transmissions, the signal strength from a wideband device—as measured at any one
location—tends to be consistent. (If the directional antenna is in use, the signal strength from a wideband
device will tend to be consistent, at a given measurement location, and for a given direction in which you
point the antenna.)

By contrast, narrowband devices have certain signal peculiarities. Small changes in the physical
environment—changes which have nothing to do with the device emitting the signal—can cause large
fluctuations in the signal strength. For example, the simple movement of people or furniture can change
the way a narrowband signal is reflected throughout the enterprise space, resulting in changes in signal
strength as measured from some distance away.

Fortunately, most interferers are wideband, which makes life easier for users of Cisco Spectrum Expert
Software. However, there are some interferers, such as some FM phones and TDD phones, which are
narrowband devices. The signal from these devices can vary significantly over the space of just a few
inches. As a result, there are some simple antenna tricks to use when searching for such devices:

e Omni antenna—If you are using the omni antenna (including the built-in antenna on the Cisco
Spectrum Expert Sensor card), it can be helpful to slowly, physically sweep the Cisco Spectrum
Expert Software laptop in an arc along several inches, until you achieve the maximum signal

strength.
¢ Directional antenna—If you are using the directional T~
antenna (Wi-Fi only), a similar trick applies. With the ‘ ~
. . | N
laptop resting in place (such as on a cart), and with the P4
antenna pointed in a desired direction, you can slowly | -
| e

sweep the antenna along an arc of roughly 30 degrees to
45 degrees, centered on the primary direction of interest,

until you achieve the maximum signal strength Solid line indicates main direction of interest for
signal measurement. Dotted lines indicate
approximately 45 degree arc of measurement

through which the antenna should be moved.

| oL-15237-01
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Cisco Spectrum Expert Software Local Settings

Local Settings Overview

~

Note

There are a number of settings you can change to determine how Cisco Spectrum Expert Software operates
and presents data. The available settings are for:

Sensors and Antennas—Determine which Sensor card Cisco Spectrum Expert Software uses to
obtain data. For the internal Sensor card, you can also indicate the type of antenna in use.

Console Settings—Use this to change the date formats seen on screen.

Band and Channel Settings—Determines which 802.11 channels and how wide a bandwidth will
be monitored by Cisco Spectrum Expert Sensor card.

Alert Settings—Used to enable or disable security and performance alerts for an interferer type or
category.

SNMP Option—Cisco Spectrum Expert Software has an ability to send SNMP traps when it detects
interfering devices. This screen is used to configure the trap filters and threshold levels that will
trigger the sending of an SNMP trap. The Settings — SNMP screen is used to configure the trap
filters and threshold levels that will trigger the sending of an SNMP trap.

The following MIB files are installed with Cisco Spectrum Expert Software under [install
dir[\Cognio\Spectrum Expert\MIB and are used by the trap receiver:

File Description

COGNIO-SMI.mib Enterprise OID

COGNIO-TRAPS-MIB.mib Trap definition. Refer to this file for the complete
trap OID information.

INET-ADDRESS.mib MIB file that traps are dependent on

SNMP-FRAMEWORK-MIB.mib = MIB file that traps are dependent on

SNMPv2-CONF.mib MIB file that traps are dependent on

SNMPv2-SMILmib MIB file that traps are dependent on

SNMPv2-TC.mib MIB file that traps are dependent on

[ oL-15237-01
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W Sensors and Antennas

Sensors and Antennas

To modify which Spectrum Sensor card and/or antennas are used by Cisco Spectrum Expert Software,
follow these steps:

Step 1 Select Tools > Settings.

The Sensor Setup panel should be displayed by default. If it is not, select the Sensors and Antennas
button on the tool bar at left.

Step2  Select the Sensor card/antenna combination of interest. Your choices are:

¢ Sensor Card With
Internal Antenna—Tells
the application to use data
from the internal Sensor
card. Also tells the Sensor
to use its internal

Settings - Sensors and Antennas

c a. |
":. 3o Sensor Sekup

Sensorsand |
Antennas | () Sensor Card with Inkernal Ankenna

7

antenna (%) Sensor Card with External Antenna
e Sensor Card With
External
Antenna—Tells the 202.11 P.utomatically skart sensor conneckion with
application to use data EPC2 these settings when softwars is launched,
ppHicatio “gi
fI‘OIIl the 1nternal Sensor v %2 Some sensor cards may seleck external vs, internal antenna

automatically in lieu of above setting.

card. Also tells the Sensor | and and charnel
. Settings
to use its external

antenna. 'E
L3

e Spectrum Capture
File— Enables you to AleitSettings
select a CSC file for =S
playback. Select the
[Browse...] button to o A
browse for a particular Cisca WCS Settings o | e
CSC file. See “Spectrum
Recording and Playback” for more information.

Step3  Optionally, select the Automatically Use These Settings At Startup check box. If you select this
option, the application will automatically use these settings each time the application is started.

If left unchecked, the Cisco Spectrum Expert Software present a dialog box each time the program starts,
asking you which Sensor card to use.

Step4  Select [OK] to confirm your changes and close the dialog box. You can also select [Apply] to apply your
changes while leaving the dialog box open for further work.

Console Settings

To fine-tune how the Cisco Spectrum Expert Software displays data, follow these steps:

Step 1 Select Tools > Settings.

Cisco Spectrum Expert Users Guide
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Step 2
Step 3

Step 4

Spectrum View
Configuration for
Playback

Date Formats Used
Throughout the
software—Select
from the drop-down
menu.

Instant Replay—
Select the checkbox
and the number of
minutes (1 to 60) you
want available for use
as an instant replay.

Default AP
Category—
In-Network or
Unknown.

Plot’s Background
Color—BIlack or
White as the
background color.

You can change the following settings:

Settings - Console

i

=

Sensors and
Antennas

Band and Channel
Settings

N

Alert Settings

Cisco WS Settings

Band And Channel Settings W

From the tool bar on the left side of the dialog box, select Console Settings

Speckrum Yiew Configuration for Playback

(%) Load From Capture File
Date Formats Used Throughout the Application
| Tue Mo 13 16:00:00 |

Inskant Replay

() Keep Current

~

Enable Instant Replay of the last | 1 | minutes
Default AR Category

(%) In-Metwork O Urkriown
Wi-Fi Interference
|:|Treat wi-Fi CCI as interference
Flot's Background Color

(@ Black O white

[ (=4 ] ’ Cancel ]

changes while leaving the dialog box open for further work.

Band And Channel Settings

Here you can configure the bands and channels that Cisco Spectrum Expert Software will monitor and
report on. You can select band and channel settings by Regulatory Domain or define the bands and
channels individually by selecting the User Defined option.

Regulatory Domain Options

To use a Regulatory Domain option to select the bands and channels:

Step 1

Select Tools > Setting.

Select OK to confirm your changes and close the dialog box. You can also select Apply to apply your

| oL-15237-01
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I Band And Channel Settings

D o on the e

side of the dialog box, select

Regulatary Domain

Band and Channel Settings. — =
& '3. ) | Americas | Australia sl
5 j | S
Step3  From the Re gulatory = a0z, 11bfg [a0z.11a
. : Sensors and
Domain pane dI'Op-dOWIl ple Antennas Monitored Bands and Channels

list select the regulatory = 802.11b/g
domain to monitor. You have - Fi e

the following options:

| ol = .o | o o |

st = 802114

rr_rr'l—lfrrl—r_rr

i
1
|
|« Es
i
i Band and Channel

|
|
1
1
|
¥ cha I
1
|
|
|

|___Zethings
A o o o o
Alert Settings - : it
e Hin|nN|n
Cisco WS Settings [ oK H Cancel ]

e For Wi-Fi, the options include: Americas/Australia, EMEA/Asia/Pacific, Japan, All Wi-Fi
Channels. For Wi-Fi, it is further possible to select the Wi-Fi standard to be covered (802.11 a,
802.11 b/g, or both) using the checkboxes. The single regulatory domain pick will apply to both
Wi-Fi standards.

~

Note  The controls in the Monitored Bands and Channels control pane also display the bands and
channels that will be monitored when a Regulatory Domain is picked.

Step4  Select OK to confirm your changes and close the dialog box. You can also select [Apply] to apply your
changes while leaving the dialog box open for further work.

~

Note  Regulatory Domains are subject to change without notice.

User Defined Option

To use the User Defined option to select the bands and channels, follow these steps:

Step1  Select Tools > Settings...
Step2  From the tool bar on the left side of the dialog box, select Band and Channel Settings.
Step3  From the Regulatory Domain pane drop-down pick list select the User Defined option.

Step4  When you selected User Defined the individual band and channel monitoring check boxes are enabled
and you can select the bands and corresponding channels to monitor.

Step5  Select one or more of the available bands from Monitored Bands and Channels control pane.

Cisco Spectrum Expert Users Guide
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Step 6
Step 7

Monitoring

Band And Channel Settings

Select one or more of the available channels check boxes for each band selected.

Select [OK] to confirm your changes and close the dialog box. You can also select [Apply] to apply your
changes while leaving the dialog box open for further work.

The Sensor card is capable of monitoring up to 1 GHz of RF bandwidth at a time. In practice, however,
monitoring this much of the spectrum can result in some performance issues for Cisco Spectrum Expert
Software. Moreover, for most practical softwares, it is rarely necessary to monitor that much of the
spectrum at one time.

The Band and Channel settings enable you to determine how much bandwidth is actually monitored by
the Sensor card. Monitoring only the bandwidth you need to monitor—rather than trying to have the
Sensor card scan its full potential range—will result in more effective system performance.

e If you change the settings for monitored bands and channels, the Cisco Spectrum Expert Software
automatically restarts, clearing all internal buffers. The display does not close down, but you lose
any data currently shown on the spectrum plots, Channel Summary, Devices View, etc.

e The bands and channels you define here determine which bands and channels are available for
selection on the spectrum plots. See “Band And Channel Settings” for more information.

e If you select two bands which are adjacent or which overlap (for example, 5.47 to 5.725 GHz, and
5.725 to 5.850 GHz), Cisco Spectrum Expert Software will automatically consolidate the two bands
into one band.

You can select one or more of the bands, such as the 2.4 to 2.5 GHz band, the 5.15 to 5.35 GHz band
(for Wi-Fi). Selecting all or most of the bands shown may result in reduced performance or data quality,
so we suggest that you select only those bands that are essential for your current monitoring and testing
needs.

[ oL-15237-01
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B Band And Channel Settings

Alert Settings

The Settings - Alert screen is used to configure security and performance alerts. This screen consists of

three tabs:

e Active Devices—This tab is used to enable or disable a security alert for an interferer type or
category. Security alerts can be enabled/disabled for one, multiple or all interferer categories.

e Spectrum—This tab is use to enable or disable alerts

¢ Channel Summary—This tab is used to enable or disable alerts for channels devices being

displayed on the Channel Summary view.

To enable performance alerts, follow these steps:

Settings - Alerts b

o

| active Devices éSpectrum ___Channel Surnmary |

[Enable Performance alerts &

, | Warning
| Interferer Duky Cele (9560 50 25

[ | critical

[JEnable Security slerts

| Category S
| [] Bluetoath

[] cordless Phones

|:| Microwave Ovens

[]so2.11FH

|:| Generic - Fixed-Frequency

Jammers

|:| Generic - Frequency-Hopped

|:| Generic - Conkinuous

[] analog video

(] wi-Fi APs {In-Hetwark) v

Set To Default

H Cancel l

Step1  Select Tools > Settings...
Step2  From the tool bar on the
left side of the dialog
box, select Alert
Settings. < :_. g
Sensars and
Antennas
BOZA1 s
v CH1
CH 2
¥ Ch)
"o
Band and Channel
Settings
_________ T
| |
| |
| |
A&
| |
|_ lrt Settigs |
Cisco WS Settings
To enable alerts for active devices, follow these steps:
Step 1 Select the Active Devices tab.
Step2 Check Enable Performance Alerts.
Step3  Check Alert only if In-Network Wi-Fi access points exists.
Step4  Check Enable Security Alerts.
Step 5

In the Category pane, check one or multiple device categories for performance monitoring and alerts.
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Step 6

Step 1
Step 2
Step 3

Step 1
Step 2
Step 3

Step 4

Band And Channel Settings

~

Note  The default settings are Jammers and Wi-Fi Ad Hocs boxes checked.

Select Apply or OK.

When the Enable Performance Alerts and the Alert only if In-Network Wi-Fi access point exists
fields are checked (selected) on the Active Devices tab, and at least one In-Network Wi-Fi access point
is present on the same channel as the interferer, all active interferers display with or with out a security
alert icon in the Active Device pane on the Main window.

e If the interferer duty cycle is greater than 50% (default critical threshold value), the device displays
in Red.

If the total duty cycle is greater than 25% (default warning threshold value), but less than 50, the device
displays in Yellow.

To enable Security Alerts for Spectrum, follow these steps:

Select the Spectrum tab.
Check the Enable Spectrum Alerts check box. The default settings are shown in the figure.
Select Apply or OK.

To enable alerts for Channel Summary, follow these steps:

Select the Channel Summary tab.
Check the Enable Channel Summary Alerts check box. The default settings are shown in the figure.

Check the Alert only if In-Network Wi-Fi access point exists check box if you want this condition to
be met before having Spectrum generate a Channel Summary alert.

Select Apply or OK.

SNMP Option Settings

The SNMP Option icon appears in the Cisco Spectrum Expert Software standard version. Use section
SNMP Option Settings to configure the SNMP settings. If you are using the Cisco enabled Cisco
Spectrum Expert Software version then refer to section 12.6 WCS Settings.

The Settings - SNMP screen is used to enable and configure the trap filters and threshold levels that will
trigger the sending of an SNMP trap for detected interferers to the designated IP Address. The screen
consists of the following two tabs:

e Basic Settings

e Filters

Basic Settings Tab

The Basic Settings tab has two primary functions; a) to enable SNMP Traps and b) identify the
designated
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Send Spectrum Data to a Remote Computer

The Send Spectrum Data to a Remote Computer area contains a checkbox titled Enable SNMP Traps
for Interfering Devices to enable the SNMP trap function and the IP Address and Computer Name
fields.

IP Address or Computer Name of the Remote Computer

The IP Address or Computer Name of the Remote Computer area provides IP Address and Computer
name fields to identify the target system for SNMP traps.

Filters Tab

The Filters tab provides criteria an interferer must meet to trigger sending a trap. The four selectable
criteria are:

e Active Channel Filter - is there an active In-Network Wi-Fi access point on at least one of the
affected channels? The default state is DISABLED.

e Interference Channel Utilization Filter - does an affected channel have an interferer utilizing more
than the user set channel utilization percentage? The default state is ENABLED and default
threshold value is 10%.

¢ Interference Power Filter - does an affected channel have cumulative power of all interference
devices at a power level within or exceeding a user set level in dBm? The default state is ENABLED.
The default value for the within range is 16 dB and the exceeding default value is -70 dBm.

¢ Interferer Type - are there specific interferer device types that you want to trigger SNMP traps? The
type of Interferer is selected on the following list: check box, when checked, enables the
scrollable list of devices check boxes for inclusion in the trap. The default setting is DISABLED.

Modifying Trap Filters Default Settings

All threshold values are editable, meaning they can be changed to reflect differing criteria.

To modify the SNMP Traps and trap filters settings, follow these steps:

Step1  Left-click in the box adjacent to the trap criteria to apply.
Step2  Edit the existing value or enter a new value.

Step3  Left-click the box adjacent to the next trap criteria to apply.
Stepd  Select <Apply>.

Step5  Select <OK>.

Trap Filter Information Content

The trap will include the following information:
e Device Uptime
e MAC Address and Power level of top five access points

e Unique Instance ID of device
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Set SNMP Traps

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

Band And Channel Settings

e Type of Device (Numeric code)

e Filter Parameters (when filter is enabled)

e Channel Number, Interference Utilization

e Access point MAC Address, Access point Power, Interference Power

e Device Parameters (when appropriate — not all devices will have all parameters):

Center Frequency
Bandwidth

Power in dBm

Duty Cycle

Channels affected
Network address
Pulses per second
Pulse duration
Modulation Type: Tone, video, AM, FM, QAM, OFDM, Chirp (Numeric code)
PLL offset

Frequency Deviation
Symbol rate

Bits per symbol
Guard interval

Peak to average power
Period

Phase

Transmit type

To enable SNMP traps, follow these steps:

Select Tools > Settings...

From the tool bar on the left side of the dialog box, select SNMP Option.

Figure 12-9: Settings — SNMP Option, Basic Settings

On the Basic Settings tab select the Enable SNMP Traps for Interfering Devices: checkbox to enable
sending SNMP traps.

In the IP Address or Computer Name of the Remote Computer area enter either the IP Address or
Computer Name in the appropriate field to identify the target system that will receive the SNMP trap

data.

Select Apply.

Select the Filters tab.
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Step 7

Step 8

Step 9

WCS Settings

~

Note

Basic Settings

Filters Tab

In the Filters tab, select the trap filter parameters that will trigger sending an SNMP trap for a detected
interferer.

Check the The type of Interferer is selected on the following list: check box, as required, to select
specific device types from the scrollable list of device type check boxes.

Select Apply or OK.

The WCS Settings icon appears in the Cisco WCS-enabled Cisco Spectrum Expert Software version.
Use section 12.6 WCS Settings to configure the WCS enabled settings. If you are using the Spectrum
Expert standard version with SNMP Option, refer to “SNMP Option Settings.”

The Settings — WCS Settings screen is used to enable and configure the filters and threshold levels that
will trigger the sending of Cisco Spectrum Expert Software data to the designated WCS IP Address. The
screen consists of the following four tabs:

e Basic Settings
e Filters Tab
e Security

e Advanced

The Basic Settings tab has two primary functions. One function is to enable SNMP Traps or Cisco WCS
functions and also to identify the designated IP Address of the remote computer where Cisco Spectrum
Expert Software data will be sent. The functions are supported by these two areas on the Basic Settings
tab:

e Send Spectrum Data to a Remote Computer - the Send Spectrum Data to a Remote Computer area
contains two check boxes:

— A checkbox labeled Enable SNMP Traps for Interfering Devices, to enable the SNMP trap
function and,

— A checkbox labeled Enable Cisco WCS Transmission of Spectrum Data, to enable the Cisco
WCS function and the IP Address and Computer Name fields.

e [P Address or Computer Name of the Remote Computer - the IP Address or Computer Name of
the Remote Computer area provides IP Address and Computer name fields to identify the target
system for either the SNMP traps or Cisco WCS transmission of Cisco Spectrum Expert Software
data.

The Filters tab provides four selectable channel affecting acceptance criteria an interferer must meet to
trigger sending a trap. The four selectable criteria are:

e Active Channel Filter - is there an active In-Network Wi-Fi Access point on at least one of the
affected channels? The default state is DISABLED.
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¢ Interference Channel Utilization Filter - does an affected channel have an interferer utilizing
more than the user set channel utilization percentage? The default state is ENABLED and default
threshold value is 10%.

¢ Interference Power Filter - does an affected channel have cumulative power of all interference
devices at a power level within or exceeding a user set level in dBm? The default state is ENABLED.
The default value for the within range is 16 dB and the exceeding default value is -70 dBm.

¢ Interferer Type - are there specific interferer device types that you want to include in the data sent
to WCS? The type of Interferer is selected on the following list: check box, when checked,
enables the scrollable list of devices check boxes for inclusion in the data sent to WCS. The default
setting is DISABLED.

Modifying Filters Default Settings

Security

Step 1
Step 2
Step 3
Step 4
Step 5

All threshold values are editable, meaning they can be changed to reflect differing criteria.

To modify the filters settings, follow these steps:

Left-click in the box adjacent to the filter criteria to apply.
Edit the existing value or enter a new value.

Left-click the box adjacent to the next filter criteria to apply.
Select Apply.

Select OK.

The Security tab provides the ability to enable security measures, using certificates, for communications
between Cisco Spectrum Expert Software and a Cisco WCS. Several selectable security level
configurations are available to provide lower or higher security levels for the remote and local computers
engaged in a Cisco WCS connection.

There are two selectable certificate options available for a remote computer (server), and two selectable
certificate options available for a local computer. The user can define the combination of certificate
criteria required in order to authorize a WCS connection. The selectable certificate-based security
options are:

e Remote computer authorization for Cisco WCS Connections - having the following options:
- Allow self-signed certificate for remote server (lower security level)
— Require CA-signed certificate from remote server (higher security level)
¢ Identifying this computer for Cisco WCS Connections - having the following options:
— Present self-signed certificate for this computer (lower security level)
— Present the following CA-signed certificate for this computer (higher security level)

There are two fields available for identifying the specific CA-certificate to be used if the CA-signed
option is selected for either the remote or local computer.

The Action if certificate information is not valid drop-down menu provides selectable actions to be taken
upon receipt of invalid certificate information.
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Advanced Tab

The Advanced tab provides an additional user definable setting for SNMP and four user definable WCS
communication polling settings in two areas on the tab. SNMP and Cisco WCS Communication
protocols function independently and can operate simultaneously. The settings are:

¢ Advanced Settings for SNMP - displays the SNMP Trap Destination Port number. The state is
grayed-out (SNMP port can’t be changed).

e Advanced Settings for Cisco WCS Communication - provides four user definable settings for Cisco
WCS Communication parameters. The default state is ENABLED and is disabled by deselecting the
Enable Cisco WCS Transmission of Spectrum Data checkbox on the Basic Settings tab. The user
definable parameters are:

— Transmit Devices information every ___ seconds. The default value is 10 seconds.

— Limit the number of Device Update records to a maximum of ___ per transmission. The default
value is 15 per transmission.

— Consider a Cisco WCS to be temporarily unavailable after ___ unsuccessful attempts. The
default value is 10 unsuccessful connection attempts.

— Attempt reconnection to an unavailable server every ___ minutes. The default value is 10
minutes.

Configure WCS Settings

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

Step 12

To configure WCS Settings, follow these steps:

Select Tools > Settings
From the tool bar on the left side of the dialog box, select WCS Settings.

On the Basic Settings tab select the Enable Cisco WCS Transmission of Spectrum Data: checkbox to
enable sending Cisco Spectrum Expert Software data to the WCS

OR

On the Basic Settings tab select the Enable SNMP Traps for Interfering Devices: checkbox to enable
sending SNMP traps.

In the IP Address or Computer Name of the Remote Computer area enter either the IP Address or
Computer Name in the appropriate field to identify the target system that will receive the Cisco Spectrum
Expert Software data.

Select Apply.
Select the Filters tab.
In the Filters tab, select the trap filter parameters that will define a detected interferer.

Check The type of Interferer is selected on the following list: check box, as required, to select specific
devices from the scrollable list of device check boxes.

Select Apply.
Select the Security tab.

Select the desired certificate security option for the remote computer and add the CA-signed certificate
as required.

Select the desired certificate security option for the local computer and add the CA-signed certificate as
required.
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Step 13 Select the action to be taken if certificate information is not valid or leave the default action (Warn)
active.

Step14  Select Apply to continue to the Advanced tab or OK to complete the procedure.

Cisco Spectrum Expert Users Guide
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Cisco Spectrum Expert and Real World Applications

The preceding sections of this manual have been devoted to an overview of Cisco Spectrum Expert, and
then a detailed discussion of how to use specific features and operational modes. This section explains
how to put Cisco Spectrum Expert Software to work in the real world of network planning, maintenance,
and trouble shooting.

A key, general principle to keep in mind is that the RF environment, by its very nature, is highly dynamic
and unpredictable. The environment varies over time as both RF sources and RF reflectors move about
or change in their activity. (And keep in mind that an “RF reflector” can be virtually anything at all,
obviously including metallic objects, but also other types of objects, and even people.) Further, some RF
sources, such as directional antennas, have a strong RF impact in limited spaces or directions. We will
see in the discussion below how the variability of the RF environment must be taken into account when
putting Cisco Spectrum Expert Software to work.

Site Survey

A site survey is a series of RF measurements conducted not only prior to network deployment, but
possibly even prior to deciding what type of network equipment to purchase. The site survey is intended
to provide a general picture of the RF environment, and particularly those aspects of the RF environment
which may influence purchase decisions. The information gained in a site survey will also contribute to
network planning (covered in the next subsection).

The primary goal of the site survey is to determine which channels/bands are acceptable for network
deployment. The survey can also suggest the number of network devices that may need to be purchased
and deployed. This is particularly crucial for those networks, such as Wi-Fi networks, where you have a
choice of the type of network equipment to purchase (802.11a, b, or g).

The Physical Movement Of The Laptop

The site survey entails physically moving your Cisco Spectrum Expert Software laptop throughout the
network space, monitoring changes in the readings as you go. You can carry the laptop, but typically you
place the laptop computer on a cart and wheel the cart about. In offices you will want to at least walk
around the perimeter of each office, and perhaps up and down and side-to-side through the center of each
office. In a hallway or corridor, it may be sufficient to roll the laptop down the center of the hallway. In
a large, open space you may want to walk up and down in lanes, much as if you were “mowing” the
carpeting or floor tiles with the laptop.

Cisco Spectrum Expert Users Guide
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We can’t tell you the exact physical “granularity” of the survey — that is, we can’t say if you should walk
up and down your office in lanes spaced five feet apart or fifteen feet apart. Partly it depends on the size
of the site you are covering — you are likely to have the time to follow a finer, more closely spaced path
in a 5,000 square foot office than in a 100,000 square foot warehouse. We can say that the more
fine-grained your site survey, the more accurate the information you will obtain. Certainly, just taking
measurements in four corners of a large space, and at the center of that same space, is generally not
sufficient.

Note  Site surveys can be done not only for indoor areas, but also for outdoor deployments of network
equipment. For example, it is now common to set up network backhaul links on the rooftops of buildings.
A site survey done on the rooftop can detect all kinds of interference activity from neighboring
transmitters. Again, the more rooftop space that is covered in the survey, the clearer and more accurate
will be the picture of RF activity.

Cisco Spectrum Expert Software Survey Data

Typically, during the survey you will want to look at the Cisco Spectrum Expert Software Channel
Summary, the Devices View, and two or three of the spectrum plots: the Real Time FFT plot, the FFT
Duty Cycle plot, and very likely the Swept Spectrogram plot.

¢ The Channel Summary tells you which channels are showing the most RF activity, and gives a
rough indication of how much of that activity is due to interferers, and how much is due to other
network devices.

— If the activity is due to interferers—and if those devices are in your space and under your
control—you may be able to either remove or shield some of the interfering devices.

— We are assuming that you have not deployed your own network yet. So, if you are picking up
activity from other network devices, these are likely to be devices in neighboring networks. If
you do not own these networks (for example, they belong to a company in an adjoining office),
you may not be able to do anything to prevent this interference. In this case, you may need to
plan your own network to use other channels or bands which are not in use by that network.

e The Devices View shows you specifically which devices are causing RF activity. The information
includes the channels on which these devices are operating. Based on this specific information, you
can start to determine whether you can mitigate or remove these devices; or whether, instead, you’ll
need to plan your network operations to work around this device activity. (For example, if the
devices cannot be removed or shielded—or just plain turned off—you may need to operate your
network on channels not affected by those devices.)

e The plots—Real Time FFT, FFT Duty Cycle, and Swept Spectrogram—can be used to obtain a
more fine-grained view of spectrum activity. Note that the Swept Spectrogram can be used to view
either RF power or RF duty cycle. The combined time and frequency view offered by the Swept
Spectrogram is also especially useful for viewing variation or stability in spectrum activity over the
time interval of a few minutes.

— These plots can be particularly useful for evaluating channels that are borderline in the Channel
Summary, or in terms of the number of devices seen on a channel in the Devices View.

Both the Channel Summary and Devices View present a summary of RF activity seen over
some extended period of time. It may be, however, that on some particular channel(s), the RF
activity is in fact bursty in nature, i.e., it is characterized by sporadic pulses of RF activity.
Because network activity itself is also bursty, such a channel may in fact acceptable for network
purposes — RF activity from non-network devices will only occasionally occur at the same time
as network RF activity.
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In other words, looking at the spectrum plots can help you determine if the interference is
constant or intermittent; and hence if the interference on a give channel is, in fact, tolerable from
a network standpoint.

The spectrum plots are also useful for detecting interference which is created by devices that are
completely unclassified by Cisco Spectrum Expert Software. While these devices will not show up in the
Devices View, and will not impact the measurements in the Channel Summary, you will see their RF
activity on the spectrum plots.

There are at least two conclusions you can generally draw from the data obtained in the above manner:

— You can determine which are your cleanest RF channels. This may determine which types of
network equipment you buy, or at least which bands or channels you set your network
equipment to use. For example, for Wi-Fi, if you find that the entire 5 GHz band is being
swamped by nearby RF activity, you can plan your network purchases and configuration to
operate in the 2.4 GHz band.

— You may find that even your best channels or bands are only relatively clean; there may still be
substantial, unpreventable RF activity. This will generally indicate that you will need to
purchase more network devices to obtain adequate network performance and coverage.

Of course, “more network devices” is a relative term. More than what? You would need to make some
kind of baseline decision for your particular network technology—for example, how many access points
would it take to provide adequate coverage for your Wi-Fi network, in a clean RF environment?—based
on the particular specifications of the network equipment. Then, if the available channels are fairly
congested with RF activity, you may need to scale that number by, say, 50% or 100%, to ensure reliable
and speedy network performance.

Rather than purchasing more network devices, another option—if significant RF interference will be an
ongoing issue—is to instead purchase more powerful network backbone devices, which can overcome
the local interference with a stronger signal.

Note, however, that boosting, say, the power of your Wi-Fi access points, does not boost the power of
the Wi-Fi stations which may be in use. (Your network environment may be a public one, where you do
not control the design or broadcast power of all the stations that may be in use.) In this case, a higher
density of backbone devices (e.g., access points for Wi-Fi) may be the only effective solution.

Additional Notes On Site Survey and the Spectrum Plots

Monitoring Multiple Bands on Spectrum Plots

A spectrum plot can only monitor one band at a time (such as 2.4 GHz or 5.15 to 5.35 GHz for Wi-Fi).
However, on a single spectrum tab, you can open more than one instance of the same type of plot (such
as the Real Time FFT). By setting each instance to monitor a different band, you can monitor at the
same time all, or almost all, of the bands of interest.

Real Time Plots vs. Software-Based Plots

The reader may note that we have not recommended the Power vs. Frequency or Power vs. Time plots
for site survey purposes. These two plots require extensive software analysis on your Cisco Spectrum
Expert Software laptop, and are intended mainly for analyzing specific RF issues (typically, RF
problems related to some unknown device).
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The plots indicated above—Real Time FFT, FFT Duty Cycle, and Swept Spectrogram—offer data
directly from the Sensor card, and are designed to give a better, more accurate picture of overall RF
activity in a particular band. It’s that band-inclusive view which is most applicable for site survey
purposes.

Conducting The Site Survey

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

We indicated, above, both that Cisco Spectrum Expert needs to be wheeled about the anticipated network
environment, and that you will benefit from using multiple Cisco Spectrum Expert modes—Devices
View, Channel Summary, and several spectrum plots—to conduct an effective site survey. So you need
to wheel the laptop about, while switching between viewing modes, in order to get the job done.

On top of this, a physical map of your site, where you can record notes of key readings, may prove
helpful as well. For Cisco Spectrum Expert users who lack a third hand, all this may pose a challenge.
In fact, though, there is a way to get the job done with just the standard-issue two hands. There is no one
mandatory method of doing the site survey, but what follows is one possible approach.

Pick a location, typically one corner of the anticipated network space, in which to start the survey. Look
at both the Devices View and the Channel Summary, to see which channels are causing the most
activity, and what devices are responsible for that activity. Make note of this information on your map
of the network space.

Switch to the spectrum view mode, and set up the plots you wish to view. Since there are two spectrum
tabs, you may want to use each tab for a different kind of plot. For example, on one tab you may set up
multiple instances of the Real Time FFT, with each instance set for a different band. On the other tab,
you might establish multiple instances of the Swept Spectrogram (again, picking a different band for
each instance), with the Trace Type set to Duty Cycle.

Wheel the Cisco Spectrum Expert laptop through the anticipated network environment. As you move,
keep your eye on the spectrum plots—Real Time FFT or Duty Cycle, as you prefer—perhaps pausing
occasionally to switch from one spectrum tab to the other.

You of course will view all the bands you’ve set to display on the plots. However, mentally, you probably
want to keep an eye on those bands which encompassed both the most active and least active channels
seen on the Devices View and the Channel Summary. The goal is to see if this activity remains fairly
consistent throughout the network space, or varies significantly.

Any time you see a significant change in the spectrum plots—either a spike in RF activity at some
frequency, or a notable drop-off—you can switch back to Channel Summary or Devices View. The
Channel Summary will likely confirm what you’ve seen on the plots, namely, that there is a notable
increase or decrease in RF activity on particular channels. The Devices View, of course, will help you
identify the particular cause(s) of that activity.

Next, switch back to the spectrum plots, and continue your walk through the network space.

Again, at appropriate points, you will want to stop and make notes on your map of the network space.
There are several possible variations on this procedure.

e In terms of how you set up your display during the survey, another option is to put two Real Time
FFT plots and two Duty Cycle plots on the same tab, covering two bands. Then put two more Real
Time FFT plots, and two more Duty Cycle plots, on the other tab, measuring two other bands.
(And—not to confuse the reader—but you always have the option of using the Swept Spectrogram,
and setting it to display either duty cycle or RF power.)
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Save the RF Map

Network Layout

¢ You could make an entire sweep through the network environment looking only at the Channel
Summary; then another sweep, along the same path, with the spectrum plots on display. After
determining those locations with the most RF activity, you may return to those specific locations and
use the Devices View to ascertain the particular RF sources involved.

e If you note a particularly high level of RF activity at some point, but the source is not obvious, the
Device Finder may help you track down the source. See Device Finder Mode for more information.

We recommend that you save the RF map you create in the course of the site survey. It will come in handy
later, both for initial network device deployment, and for charting any changes in your RF environment
over time.

Drawing Conclusions

At the conclusion of this process—and with your marked up network map in hand—you should have a
very clear picture of which frequencies are relatively clear, and which frequencies are relatively crowded
with RF activity, throughout your network space. Ideally, it will be immediately clear which channels or
bands you wish to use for your network deployment.

Conceivably, you may find that certain bands would be best to use at some locations in your network
environment, while other bands would be better to use elsewhere. In the worst case, these bands may be
hardware incompatible (e.g., you’d want to use 802.11b/g in part of your network, and 802.11a in
another part). In this case, part of your network planning may entail removing or shielding some current
sources of RF activity, to free up a particular band in a particular location.

As indicated above, the general level of network activity will also help you determine the number of
network backbone devices that you need.

Antenna Options

The Wi-Fi version of Cisco Spectrum Expert has an optional directional antenna. Normally though,
during the initial phase of a site survey, you will want to use the standard omni antenna, so that at each
location you can pick up RF activity from all possible sources in the vicinity.

In some cases, you may find RF activity that is highly localized, without the source being apparent. (This
can happen, for example, if there is a directional broadcast antenna at some distance. You will only pick
up a signal when you happen to cross the path of the antenna beam.) At these locations, the directional
antenna can be used to help determine the exact direction of the source of RF activity. See “Using the
Directional Antenna” for more information.

Network Layout

Once you have purchased your network backbone equipment—such as access points for Wi-Fi—Cisco
Spectrum Expert can support a dynamic, real-time network layout process that results in near-optimum
placement of access points, etc. Here again you will rely upon the Devices View, the Channel
Summary, and the spectrum plots (Real Time FFT, Duty Cycle, and/or Swept Spectrogram).
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Placing the First Access Point

Step 1

Step 2

Step 3

Step 4

To start the process of deploying devices, follow these steps:

Select a location for placement of your initial access point. Of course, you’ll need to select a location
that is sufficiently close to an Ethernet connection for your wired LAN.

In addition, you’ll want to select a location which you had determined, in the course of your site survey,
to have low RF interference. (Again, we recommend that you save the RF map that you created during
your RF site survey.)

At the selected location, you’ll use to Cisco Spectrum Expert to double check that RF activity remains
at acceptably low levels in the channel you intend to use. (Depending on your overall environment, the
RF activity may or may not vary substantially over a relatively short time frame. For example, a
neighboring office may have rearranged or reconfigured their WLAN in ways that will affect your
network deployment.)

As with the site survey, you can use the Channel Summary and spectrum plots to check the overall level
of RF activity at the selected location. The Devices View can tell you about any specific devices that are
now causing interference, and which can possibly be removed or shielded. If there is new, and
uncontrollable, RF interference which had not been detected during the site survey, you may need to
select another location for initial access point deployment.

You have selected a location for the initial access point, set it in place, and probably wired it into the
WLAN. Before powering up the access point, you should set one of the Real Time FFT plots to monitor
the channel which will be used by the access point. When you turn on the access point, you should see
an immediate and dramatic gain in RF power in that channel. This tells you that the access point is
broadcasting RF on the appropriate channel.

You will now turn to the Devices View. Cisco Spectrum Expert should quickly detect and classify the
access point, so that it is shown in Devices View. Of the most interest is the Signal Strength field.
Normally, the signal strength near to the access point should be well above -70 dBm.

~

Note  The expected, near-to-the-device signal strength will vary depending on the type of network you
are deploying. Similarly, the too-low-for-reliable-operations power level (discussed below) will
also vary depending on the network technology you are implementing. The values described
here, in the range of -70 to -80 dBm, are appropriate for Wi-Fi network access points.

Placing the Second Access Point

Step 1

To place the second access point, follow these steps:

With Cisco Spectrum Expert once again in hard or on a rolling cart, you now want to move in some
direction away from the access point you have just placed. The direction you choose will depend on your
general plan of network deployment, as well as on the RF map created during the site survey.

For simplicity of description here, we’ll assume you are laying out your network in some relatively, wide
open space, such as a warehouse or airport terminal. Naturally, if you are in a more constrained space,
such as an office, your movements will probably entail leaving one room and entering the adjacent room,
or possibly walking down a hallway outside the room.
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Step 2

Step 3

Step 4

Step 5

Step 6

Network Layout

In general, your goal for placing the next access point is to aim for location which is again structurally
convenient—for example, you may want to remain close to a wall, so the access point is relatively out
of the way of other activity and movement—and of course, is close to another Ethernet connection.

As you move Cisco Spectrum Expert in the general desired direction, keep an eye on the device Signal
Strength on the Devices View. When the Signal Strength falls to around -70 to -80 dBm it is an
indication that the first access point can no longer reliable communicate with network devices at your
current location.

Choosing the higher threshold value, -70 dBm, will provide greater network reliability, at the price of
placing access points closer together. That will mean purchasing more access points. The lower
threshold, -80 dBm, may result in somewhat less network reliability and/or data rates, but also involves
deploying fewer access points.

At this point, where the access point signal strength has dropped to -70 dBm or -80 dBm, you will
probably want to deploy the next access point. You should set the new access point to a channel
substantially apart from the channel used for the first access point. (For example, you might vary your
access points between channels 2, 5, and 8, or 1, 6, and 11.)

¢ However, before “committing” your access point to this new location, you should use Cisco
Spectrum Expert to double-check a few things:

¢ Using the Channel Summary, make sure that the channel you have in mind is reasonably free of
local interference.

e Check the spectrum plots to ensure that the location is fairly free from excessive RF activity of all
kinds.

e Asusual, if you encounter undesirable RF activity at the location of interest, you will either need to
take steps to mitigate the interference; you will need to deploy a more powerful access point; or you
will need to choose another location.

Set the second access point in place at the new location, and wire it into the WLAN. Set one of the Real
Time FFT plots to monitor the channel which will be used by the access point. When you turn on the
access point, you should see an immediate and dramatic gain in RF power in that channel. This tells you
that the access point is broadcasting RF on the appropriate channel.

Again turn to the Devices View. Cisco Spectrum Expert should quickly detect and classify the access
point, so that it is shown in Devices View.

Placing Successive Access Points

From here, you will continue the deployment process in a similar manner, repeating steps With Cisco
Spectrum Expert once again in hard or on a rolling cart, you now want to move in some direction away
from the access point you have just placed. The direction you choose will depend on your general plan
of network deployment, as well as on the RF map created during the site survey. through Again turn to
the Devices View. Cisco Spectrum Expert should quickly detect and classify the access point, so that it
is shown in Devices View. Again turn to the Devices View. Cisco Spectrum Expert should quickly detect
and classify the access point, so that it is shown in Devices View. . You may very likely need to go back
to the first access point, and head off in a new direction—at right angles to your first path, or directly
opposite—to place the third access point. Depending where each access point is placed in your overall
network environment, you may need to place anywhere from one to four access points that are adjacent
to it at some distance.
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e In each case, however, as you travel away from an access point, an indication that the access point
no longer provides adequate signal coverage is when the access point’s signal falls to around -70 to
-80 dBm.

e Also, be sure that adjacent access points are not broadcasting on the same channel.

After-Deployment Site Survey

Long-Term

After deploying all your access points, you will want to conduct another site survey. This time, you do not
need to cover all the ground, as with the initial survey. However, you want to focus on areas which, just by
“eyeballing” your access point layout, you can see are relatively far from any one access point.

In those areas, you will want to move Cisco Spectrum Expert around a bit, and use Cisco Spectrum Expert’s
Devices View to ensure that at least one access point is clearly detectable, preferably, giving a Signal
Strength greater than -70 dBm. This ensures that any device in the area will be able to communicate with at
least one access point.

In addition, you may want to activate some of the known interferer devices that operate within or near the
perimeter of your network—cordless phones, microwave ovens, etc. You can use both the spectrum plots
and the Channel Summary to see if any of these devices are swamping the RF environment with so much
energy that they are likely to impede RF communications. If that is the case, you can deploy additional
access points, or more powerful access points, to compensate for the interference.

Trend Analysis

Your network’s RF environment can change over time, requiring adaptive changes in your network
deployment. Quite typically, these changes will be for the worse—more RF activity, and more
interference—as your organization grows, and the number of wireless devices (both network related, and
interferers), increases as well. You may need to deploy more network backbone devices (access points,
Wi-Fi Readers, etc.), or more powerful devices, to compensate for the change.

Ideally, you would like to know about emerging RF trends before they impact your network. Cisco
Spectrum Expert can be used for systematic monitoring and recording of the RF environment, enabling
you to observe emerging trends. The key tools here are: the Devices View, the Channel Summary, the
spectrum charts, the screen capture feature, and the record/playback feature.

Trend Analysis Procedure

The general strategy is to pick a number of key locations in your network environment, and record
spectrum data at those locations at regular intervals. How frequent those intervals should be depends on
your own assessment of the pace of change in your network environment. At a small but rapidly growing
startup company, you may want to make measurements as often as every two weeks. At a much larger,
established organization, with a more gradual growth curve in staff and activity, once every two months
might be sufficient.

You can record data both in the form of CSC files, which capture real-time data for later playback (See
“Spectrum Recording and Playback” for more information). For screen shots, you can maintain a
notebook where you store printouts of the capture screen shots. The screen images should be annotated
by both date and location. Flipping through the pages in date order (or laying them out on a table for
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side-by-side comparison) will make it easy to see significant trends in network and RF activity.
Similarly, you can view successive CSC files, one after another; do discern any important increases in
RF activity.

Type Of Data To Record

We recommend the following types of data as being most useful for long-term trend analysis.

Devices View—The particular RF devices in use at any given moment can vary widely during the
course of a day. However, you can set the Devices View to display all devices that have been used
during an extended period of time during the day, such as the last four hours or the last twelve hours.
This will create a broad picture of all the RF devices in use during a typical day, or large part of a
day. If you capture this data at regular intervals (every few weeks, every few months), you can see
if there is substantial growth in device usage.

You can also see if a particular type of device is being used more and more, and can make a decision
as to whether the type of device in question is like to impact network operations.

Channel Summary—This view of the RF spectrum indicates the amount of activity on each
channel. Taking “snapshots” of this information at regular intervals will help you determine if any
particular channels are become crowded with excess activity. This may result in you choosing to
change the channel assignments for your network backbone devices.

Note The Channel Summary is a snapshot view of “right now.” Like the use of devices, channel

usage can vary significantly over the course of a day. Therefore, on the days when you elect to
record data for long-term trend analysis, you may want to capture channel usage at several times
during the day. This will make it easier to determine which channels have consistently high
activity or low activity.

Time-Oriented Charts—The time-oriented spectrum charts—Devices vs. Time and Channel
Utilization vs. Time—are the ideal tool to ascertain overall RF activity over the course of a single
day. By setting the time interval to 8 hours or 24 hours, you can obtain a global view of RF activity
over the course of a day. (8 hours, of course, is appropriate for most office environments; while the
24 hour view is appropriate for environments—some factories and warehouses, airports,
etc.—which are the hub of day and night activity.)

Since a single Devices vs. Time chart can display, at most, four different types of devices, you may
want to put two charts on display at the same time, to capture up to eight different device types.
Similarly, the Channel Utilization vs. Time chart can only display data for one band; putting
multiple instances of the chart on display enables you to record data for multiple bands.

As discussed above, the goal is to take screen captures of these charts at regular intervals in time
(for example, every two weeks), noting both the location and date. After some extended time has
passed (typically several months), placing the charts from different dates side-by-side, in ascending
date order, will clearly indicate significant increases in the number of devices in use, or the RF duty
cycle, or both.

Channel-Oriented Charts—The Devices vs. Channel and Channel Utilization charts provide
more specific information about RF usage. While they only cover a fixed, short interval of
time—they update approximately every twenty seconds—they provide a clearer indication of
specifically which channels are being impacted by RF activity. As with the Channel Summary
display, discussed above, we recommend that on your “trend analysis days”, you take snapshots of
the channel-oriented charts at several times over the course of the day. This will help provide a
combined time and channel-oriented view of RF activity.
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Routine Network Monitoring and Trouble-Shooting

Once you network is up and running, Cisco Spectrum Expert enables you to monitor the RF environment
on a daily basis, often detecting potential problems before they become apparent to users. In addition,
when users to flag problems, such as network slowdowns or lost connectivity, Cisco Spectrum Expert
enables you to quickly pinpoint the source of the problem.

Routine Monitoring

For routine monitoring, we suggest that you set one of the two spectrum tabs to display the following
plots and charts: Real Time FFT, FFT Duty Cycle, Swept Spectrogram, and all of the spectrum charts
(Active Devices, Channel Utilization, Channel Utilization vs. Time, Devices vs. Channel/Time).

Notice that more than one Devices vs. Time plot is in use (lower right of the picture). This is because
each such plot can track a maximum of four device types. To track more than four devices, you need to
put at least two such plots into use. Similarly, you have the option of using more than one Real Time
FFT plot, or FFT Duty Cycle plot, in order to monitor additional bands.

Monitoring Points and Monitoring Rotation

The general procedure for routine monitoring is to pick selected monitoring points throughout your
network environment.

e Throughout the day, you move Cisco Spectrum Expert from one monitoring location to another,
holding your position at each location for some extended length of time (say, one hour, or two
hours).

¢ In alarge network environment—and depending on how many Cisco Spectrum Expert computers
you have, and the size of your network support staff—you may not be able to cover all of your
monitoring points in a single day. Instead, you may have a rotation among monitoring points that
takes, say, a full week to complete, and then starts again, covering the same points, the following
week.

e Vary The Sampling Times — If possible, each set monitoring point on your route should NOT be
always sampled at the same time of day. As a very simple example, and supposing you had just five
designated monitoring points (call them A, B, C, D, and E), and exactly one Cisco Spectrum Expert
computer, you might employ a rotation similar to the following:

.Time Slot .Monday .Tuesday .Wednesday .Thursday Friday
.8 am.to 10 a.m. A B .C D E
.10 a.m. to Noon B C .D E A
.Noon to 2 p.m. C D .E A B
.2 p.m. to 4 p.m. D E A B C
4 p.m. to 6 p.m. E A .B C D

The point is to make sure that each location is monitored at different times of day, because it is
possible that certain locations have low network utilization at one time of day, and higher utilization
at another time of day.

¢ Selection of Monitoring Points — As for the selection of monitoring points, you will typically seek
a mix of locations, some of which are relatively near to your network backbone devices (such as
access points); while others are relatively from the network backbone devices.
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The goal is both to make sure that monitoring points far removed from the network backbone have
a healthy RF environment, so they can pick up signals from the backbone; and also to ensure that
the backbone devices themselves will be able to clearly receive signals from network members.

e Variation Analysis — In Section Long-Term Trend Analysis, Long-Term Trend Analysis on page 8
Long-Term Trend Analysis, we discussed capturing screen shots, or recording spectrum activity, as
a tool for long-term trend analysis. Conceivable, you could use this daily monitoring as the core of
that long-term trend analysis. However, in fact, recording and storing data from multiple locations
every single day is likely to result in an overwhelming amount of data; that’s why we recommend
measurements intended for long-term trend analysis be taken at longer intervals.

However, what you can do is make spectrum recordings or spectrum screen shots on a daily basis
during the week; and then compare the recordings/screen taken at the same location, but on different
days of the week, and at different times. This comparison will quickly reveal any unexpected,
dramatic changes in the RF and network environment:

You can quickly determine if a particular location has dramatically increased activity at different
times of day.

If you measure the same location, at the same time, at the beginning of a week, and again at the end of
the week, you can immediately detect any abrupt change in RF activity. This can occur, for example, if
a new RF device (say, a new microwave oven) was installed during the course of the week, and is now
introducing unacceptable levels of RF.

RF and Device Monitoring

Using the spectrum view configuration described above:

e Spectrum Charts—The spectrum charts will show you if there is an excess of RF activity on a given
channel, or an excess of devices on a given channel. You can also see how RF activity and device
activity vary over time.

¢ Spectrum Plots—The Real Time FFT, FFT Duty Cycle, and the Swept Spectrogram all help you
detect “bursty” RF activity, which may or may not register strongly on the spectrum charts (the
charts generally reflect more sustained trends in RF activity). Bursty RF activity can cause network
transmission and reception problems, even if the spectrum charts seem to show a relatively clear
environment.

e Active Devices Chart and Active Devices Tree—Together, these two display elements provide a
clear picture of just which types of devices—network or interferer—are active in the network
environment. The Active Devices Tree will also show you if there are network devices impacting
your network, but which are not actually part of your network (e.g., access points from neighboring
Wi-Fi networks).

Trouble-Shooting

In addition to routine monitoring, there will be times when a network user (or, on a bad day, users), notify
you about problems with network performance or connectivity. In these cases, you will want to take
Cisco Spectrum Expert to the location(s) where the problems are being reported, and scan the same plots,
charts, and the Active Devices List, as described above.

It is possible that the flawed network activity will be intermittent. You can set Cisco Spectrum Expert in
place at the location where the troubles are reported, and set it to record spectrum data over the course
of a day for later review. At the conclusion of monitoring, you can also look at the Devices View, which
presents an historical view of devices that were seen over a period of up to 24 hours.
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Problem Resolution

Device Finder

Once a problem has been detected, and the general cause has been ascertained—such as too many
devices in use, or excessive interference on a particular channel—the exact nature of the solution will
vary depending on the problem at hand.

In some cases, the cause of the problem is immediately evident—for example, a new microwave oven

has been put into use, and the RF leaking from the microwave can be clearly seen as increasing the duty
cycle every time the microwave is turned on. Solution: Move the microwave, shield the microwave (or,
possibly, try eating cold food). Similarly, the office may just have gone from standard wired-phones to
cordless phones, and the new phones are causing the interference. The solution here may be to change
the channel used by the network backbone devices.

In still other cases, it may be that more and more network devices are being put into use—for example,
as more staff is hired, more wireless computers are used—and a threshold has finally been reached where
the existing network backbone (access points) can no longer handle the traffic. The solution here is to
purchase additional access points, or reallocate some access points from locations where network
demand is not as strong.

In other cases, the general nature of the problem may be apparent, but the particular cause is not. For
example, the plots and charts may clearly show increased RF activity when some device is coming into
use—but the device itself is not known. (For example, it may be a generic device, and the network
administrator does not recognize what device is actually implicated, based solely on the generic
parameters.)

In this case, Cisco Spectrum Expert’s Device Finder feature becomes an essential tool for tracking down
the ill-behaving RF device. See “Device Finder Mode” for more information.
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Notices, Third Party, and Public Software
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Copyright © 1992-2007 Cisco Systems, Inc. All Rights Reserved.
Multiple Patents Pending.

Portions of the Cisco Spectrum Expert™ contain third party and public software. The following notices
and license agreements are provided in compliance with the applicable license agreements.

Alteration of Apache Log4Cxx Library
>

Note  The Apache Log4Cxx library that is included with the Cisco Spectrum Expert product has been modified
by Cisco to support UNICODE. This is a non-standard build of this library.

The Xerces XML library, LOG4CXX logging library, and Apache Portable Runtime (APR) libraries are
licensed under the Apache license reproduced below:

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

Terms and Conditions for Use, Reproduction, and Distribution

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means (i)
the power, direct or indirect, to cause the direction or management of such entity, whether by contract
or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

Cisco Spectrum Expert Users Guide
[ OL-xxxxx-xx .m



Chapter 15 Notices, Third Party, and Public Software Statements for Cisco’s Spectrum Expert |

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces
of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized
to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including
but not limited to communication on electronic mailing lists, source code control systems, and issue
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and
improving the Work, but excluding communication that is conspicuously marked or otherwise
designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work, where such license applies only to those patent claims licensable by such Contributor
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution
incorporated within the Work constitutes direct or contributory patent infringement, then any patent
licenses granted to You under this License for that Work shall terminate as of the date such litigation is
filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent,
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not
pertain to any part of the Derivative Works; and
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(d) If the Work includes a "NOTICE" text file as part of its  distribution, then any Derivative Works
that You distribute must  include a readable copy of the attribution notices contained  within such
NOTICE file, excluding those notices that do not  pertain to any part of the Derivative Works, in at
least one  of the following places: within a NOTICE text file distributed  as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices normally
appear. The contents  of the NOTICE file are for informational purposes only and do not modify the
License. You may add Your own attribution  notices within Derivative Works that You distribute,
alongside  or as an addendum to the NOTICE text from the Work, provided that such additional
attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work
otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall
supersede or modify the terms of any separate license agreement you may have executed with Licensor
regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise
of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts)
or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect,
special, incidental, or consequential damages of any character arising as a result of this License or out
of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if
such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or
other liability obligations and/or rights consistent with this License. However, in accepting such
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.
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END OF TERMS AND CONDITIONS

OpenSSL License.

http://www.openssl.org/source/license.html

LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit.

See below for the actual license texts. Actually both licenses are BSD-style

Open Source licenses. In case of any license issues related to OpenSSL please contact
openssl-core @openssl.org.

OpenSSL License

/*
* Copyright (¢) 1998-2007 The OpenSSL Project. All rights reserved.
*

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

*

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

*

* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the

*  distribution.

*

* 3. All advertising materials mentioning features or use of this

*  software must display the following acknowledgment:

*  "This product includes software developed by the OpenSSL Project
*  for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

*

* 4, The names "OpenSSL Toolkit" and "OpenSSL Project”" must not be used to
* endorse or promote products derived from this software without

*  prior written permission. For written permission, please contact

*  openssl-core@openssl.org.
*
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* 5. Products derived from this software may not be called "OpenSSL"

* nor may "OpenSSL" appear in their names without prior written

*  permission of the OpenSSL Project.

k

* 6. Redistributions of any form whatsoever must retain the following

* acknowledgment:

*  "This product includes software developed by the OpenSSL Project

*  for use in the OpenSSL Toolkit (http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ""AS IS" AND ANY

* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

* TS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.

*®

*

* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).

*

*/

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

* All rights reserved.

*

* This package is an SSL implementation written

* by Eric Young (eay@cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
*

* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* Thash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).

*

* Copyright remains Eric Young's, and as such any Copyright notices in
* the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or

* in documentation (online or textual) provided with the package.
*
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* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

*  notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. All advertising materials mentioning features or use of this software

*  must display the following acknowledgement:

*  "This product includes cryptographic software written by

*  Eric Young (eay@cryptsoft.com)"

*  The word 'cryptographic' can be left out if the rouines from the library

*  being used are not cryptographic related :-).

* 4. If you include any Windows specific code (or a derivative thereof) from

*  the apps directory (application code) you must include an acknowledgement:

*  "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

*

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* [including the GNU Public Licence.]

*/

Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the
software and accompanying documentation covered by this license (the "Software") to use, reproduce,
display, distribute, execute, and transmit the Software, and to prepare derivative works of the Software,
and to permit third-parties to whom the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above license grant, this
restriction and the following disclaimer, must be included in all copies of the Software, in whole or in
part, and all derivative works of the Software, unless such copies or derivative works are solely in the
form of machine-executable object code generated by a source language processor.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE
LIABLE

FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE
USE OR OTHER DEALINGS IN THE SOFTWARE.
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